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ROLE OF SELF INSTRUCTIONAL MATERIAL

IN DISTANCE LEARNING

The need to plan effective instruction is imperative for a suc-

cessful distance teaching repertoire. This is due to the fact that the in-

structional designer, the tutor, the author (s) and the student are often

separated by distance and may never meet in person. This is an increas-

ingly common scenario in distance education instruction. As much as

possible, teaching by distance should stimulate the student’s intellectual

involvement and contain all the necessary learning instructional activi-

ties that are capable of guiding the student through the course objec-

tives. Therefore, the course / self-instructional material are completely

equipped with everything that the syllabus prescribes.

To ensure effective instruction, a number of instructional design

ideas are used and these help students to acquire knowledge, intellectual

skills, motor skills and necessary attitudinal changes. In this respect,

students’ assessment and course evaluation are incorporated in the text.

The nature of instructional activities used in distance education

self- instructional materials depends on the domain of learning that they

reinforce in the text, that is, the cognitive, psychomotor and affective.

These are further interpreted in the acquisition of knowledge, intellec-

tual skills and motor skills. Students may be encouraged to gain, apply

and communicate (orally or in writing) the knowledge acquired. Intel-

lectual- skills objectives may be met by designing instructions that make

use of students’ prior knowledge and experiences in the discourse as the

foundation on which newly acquired knowledge is built.

The provision of exercises in the form of assignments, projects

and tutorial feedback is necessary. Instructional activities that teach motor

skills need to be graphically demonstrated and the correct practices pro-
vided during tutorials. Instructional activities for inculcating change in

attitude and behavior should create interest and demonstrate need and

benefits gained by adopting the required change. Information on the adop-

tion and procedures for practice of new attitudes may then be intro-

duced.



Teaching and learning at a distance eliminates interactive com-

munication cues, such as pauses, intonation and gestures, associated with

the face-to-face method of teaching. This is particularly so with the ex-

clusive use of print media. Instructional activities built into the instruc-

tional repertoire provide this missing interaction between the student

and the teacher. Therefore, the use of instructional activities to affect

better distance teaching is not optional, but mandatory.

Our team of successful writers and authors has tried to reduce

this.

Divide and to bring this Self Instructional Material as the best

teaching and communication tool. Instructional activities are varied in

order to assess the different facets of the domains of learning.

Distance education teaching repertoire involves extensive use of

self- instructional materials, be they print or otherwise. These materials

are designed to achieve certain pre-determined learning outcomes,

namely goals and objectives that are contained in an instructional plan.

Since the teaching process is affected over a distance, there is need to

ensure that students actively participate in their learning by performing

specific tasks that help them to understand the relevant concepts. There-

fore, a set of exercises is built into the teaching repertoire in order to

link what students and tutors do in the framework of the course outline.

These could be in the form of students’ assignments, a research project

or a science practical exercise. Examples of instructional activities in

distance education are too numerous to list. Instructional activities, when

used in this context, help to motivate students, guide and measure stu-

dents’ performance (continuous assessment)



PREFACE

We have put in lots of hard work to make this book as user-friendly

as possible, but we have not sacrificed quality. Experts were involved in

preparing the materials. However, concepts are explained in easy

language for you. We have included many tables and examples for easy

understanding.

We sincerely hope this book will help you in every way you

expect.

All the best for your studies from our team!



MOTION GRAPHICS (Software-Adobe After Effects)

Block 1 INTRODUCTION

UNIT 1 INTRODUCTION TO COMPOSTING
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Composition
 Types of Compositions
 Video Editing
 Types of Editing
 Video Broadcasting Standards
 After Effects Interface
 Importing files in After Effects
 Creating New, Opening and Saving compositions
 Familiarity with Timeline

UNIT 2 EXPLAINING TOOL BOX
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Understand Flow Charts
 About the Tool Box
 About the functioning of various tools and where they can be

used
 About Guides and Grids
 Various commands in Layer, View and Edit Menu
 Functions of various switches in the timeline/layer menu.
 Familiarity with Timeline

UNIT 3 LAYER NESTED COMPOSITION  AND MASKING
Learning Objectives:

 About Masking
 How Masking is done and various uses of masking
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.

Block 2: ANIMATION AND EFFECTS
UNIT 1 ANIMATION
Learning Objectives:

 How to do Animation in After Effects
 How to increase or decrease the speed of the footage
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.
UNIT 2 EFFECTS
Learning Objectives:

 Various Effects available in After Effects



 Use of Blur and Sharpen Effects
 Use of 3D Effects
 Use of Channel
 Use of Colour Correction

UNIT 3 SOME MORE EFFECTS
Learning Objectives:

 Various Effects available in After Effects
 Use of Render Effects
 Use of Stylize Effects
 Use of Text Effects
 Use of Audio

Block 3 ADVANCED KEYING,MATTE AND ANIMATION
TECHNIQUE

UNIT 1 KEYING AND MATTE
Learning Objectives:

 Learning about advanced Keying
 Learning about advanced matte

UNIT 2 ADVANCED ANIMATION TECHNIQUES
Learning Objective

 Learning about animation techniques
 Learning Motion Tracking
 Learning Stabilizing
 Learning Motion Sketching

Block 4 3D AND RENDERING IN AE
UNIT 1 3D MOTION IN AFTER EFFECTS
Learning Objective

 Learning about 3D in After Effects
 Learning use of 2D layers in 3D World
 Learning about 3D layer options and transformation Properties
 Learning 3D compositions of position, rotation, shadow,

reflection and other effects by examples
UNIT 2 RENDERING
Learning Objective

 Learning to make Textures for Different Creatures
 Learning to make Textures for Cat, Rat, Lion, Reptiles, Birds,

Fishes, Turtles, Mammals, Wild Animals, Pets, Etc
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INTRODUCTION TO
COMPOSTING

UNIT
1

Learning Objectives:
 After reading this unit, you will learn:
 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Composition
 Types of Compositions
 Video Editing
 Types of Editing
 Video Broadcasting Standards
 After Effects Interface
 Importing files in After Effects
 Creating New, Opening and Saving compositions
 Familiarity with Timeline

: Structure :
1.1 Introduction to After Effect & Parent Company
1.2 Briefing about composting and video editing
1.3. Explaining different types of editing and composting
1.4. Showing of Interface and different panels.
1.5. File menu options
 1.5.1 New Project
 1.5.2 New Folder
 1.5.3 Open
 1.5.4 Save
 1.5.5 Save As
 1.5.6 Save A Copy
 1.5.7 Increment and Save
 1.5.8 Revert
1.6. Explaining Composition
1.7. New Composition
 1.7.1 NTSC
 1.7.2 PAL
 1.7.3 All Pixel Ratios
 1.7.4 Frame Rate
 1.7.5 Duration
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1.8. Importing of File of different format in PROJECT Panel
 1.8.1 Importing of Multi-layer Photoshop File
 1.8.2 Importing of Multi-layer Premiere File
 1.8.3 Transparency
1.9. Quality
1.10 Timeline
 1.10.1. Inserting of file in Timeline
1.11 Viewing of File in Composition Panel
1.12. Showing All options of composition Panel
 1.12.1 In-Out points
 1.12.2 Take snap shots
 1.12.3 Channels
 1.12.4 Title & Action Safe
1.13. Summary
1.14. Self Assessment Test
1.15. Further reading
1.16. Assignment

1.1 Introduction After Effect & Parent Company
Adobe was founded in December 1982 by John Warnock and Charles
Geschke. The name Adobe came from Adobe Creek in Los Altos,
California, which ran behind the house of one of the company’s founders.
The company focuses upon the creation of multimedia, creativity and
rich Internet application software development.
Adobe After Effects is a video post-production software which is used
for digital motion graphics and compositing. It is primarily used for
creating visual effects in video production as well as film production. It
supports 2D and 3D work space. The main interface consists of several
panels, most commonly used are the Project panel, Composition panel
and Timeline panel.
Adobe acquired After Effects from Aldus Corporation along With
PageMaker. The first release of Abode After Effects was version 3 in
1995.

1.2 Briefing about compositing and video editing
Compositing:
The word “Compositing” is actually how we merge the scenes to-gather.
The compositing can be between a simple motion graphics and a still
image, 2 still images and then animating it later by using special effects
or by fame animation, text animation with a movie or a background, etc.
now a days the compositing takes place in a large scale. With the
composition we can even rub off the mistakes.
In very simple words, Video Editing is the process of creating one final
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video out of different video clips. This process involves cutting, trimming,
adding transitions etc. of the video clips and placing them in order as per
the story. Compositing is generally used to enhance the actual footages.
Objects can be added, removed or altered as per the requirement with
the compositions.

1.3.  Explaining different types of editing and composting
For a better composition, a strong concept is must. Before the start of
making the concept you have to generate or find out the concept you
want to highlight from the composition. It is very simple that before
making the thing you have to decide what you want to generate as the end
result of the composition.
The importance of a composition is like the importance of the heart in
the body. If the arrangement of the elements in the art work is not proper
the idea or message cannot be fulfilled properly. Without the composition
or proper arrangement all the elements in the art work cannot generate
the effect to the viewer that much strongly
Types of Composition
· Quadrant: This arrangement divides the area of Art work in to four

same size parts.
· Sequential: Here the data content should be equally placed in the

two vertical parts of the page.
· Asymmetrical: Here the page is having more data in one side of

the page.
· Golden mean: Here the data is arranged in the manner so the eyes

go to the main object or subject of the art work.
 Majorly there are 2 types of video editing:
1. Off-Line Editing: This type of editing is used for lower quality

copies of the original clips and then produces the final version on a
high-end system. It is developed for less expensive editing. In other
words, Off-line editing is first done on a lower end editing system
and then the edited data is used on a high end system (the desired
system) to produces the final cut.

2. On-Line Editing: This type of editing is the practice of doing all
types of editing including rough cut that will produce a final cut.
The On-line Editing is entirely done on a high-end system.
Well, there are other two types of editing in the Off-Line Editing
which are mostly use in today’s editing world.
They are as following:

1. Linear Editing: In linear editing, the source is played on a player
which is connected to a display terminal (T.V) and a recorder which
records the video as final cut. The editor plays the source footage
on the player and when he is sure about the clip to be recorded for
the final output, he plays the clip on the player and records the same
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on the recorder. In practice multiple sources are used for playback
and the editor keeps switching between the sources. These days this
kind of editing is done when the program, news, sports or any other
kind of video is telecasted at the same time when it is recorded like
we see the live telecast of cricket or foot ball matches etc.
Here the editor must be very accurate as if a mistake happens you
have no time to correct it as the moment you finish editing it is
directly telecasted. This kind of editing is generally very straight
and simple due to the shortage of time as it is direct telecasted.

2. Non-Linear Editing: This kind of editing is done for movies,
serials, interviews, Re-telecast of a match etc. All these can be edited
again and again as they are captured and stored and afterwards they
are edited so there are no risk factors for mistakes as you get enough
time for editing.
However here also you have time limits but it gives a certain amount
of time for working on the same project so you can correct the
mistakes even after rendering if needed. This kind of editing can
have more effects and transitions in to it. It is called Non-linear
because it is not done in a linear fashion i.e. the editor can place the
cuts on the timeline from the same footage and then later on he can
insert, move, clip, trim or do lots of other operations on the clips.
The clips can be reordered at any time unlike linear editing where
clips once recorded cannot be reordered. Non-Linear editing is done
on computers.

1.4.  Showing of Interface and different panels.

Fig 1.1 Showing the interface of the After Effects
Adobe After Effects’ interface is divided into different set of Panels
(previously known as windows). There are three major panels:
1. Project Panel
2. Composition Panel
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3. Timeline Panel
Project Panel is the main panel where all your imported data (Images,
Footages and sound) as well as created data (Compositions, new solid
layers, camera layers etc) are stored.
Here we get details of the file that is imported in the form of file name,
path of the file, size, dimensions, frame rate, duration, depth of the colour,
format and the details of the audio if the imported file is an audio file or
the file contains audio in it.
Project panel have few buttons and options like a search box for searching
assets (like images, footages, sound etc.) with in the project panel. At
the bottom of the panel there are buttons for creating new folder, creating
new compositions, deleting selected objects etc.

Fig 1.2 Project Panel
Thumbnail preview: It shows you the preview of the selected item
(Footage, Sound and Image). In case of Footage with sound you will see
a green bar at the bottom of the thumbnail which indicates that the footage
has audio associated with it. On the right hand side of the thumbnail it
displays information about the selected object.
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Fig 1.3 Thumbnail preview.
Search Box: You can use the search field in the Project panel to find
footage items that meet various criteria, such as those with missing source
files.
Interpret Footage: After Effects uses a set of internal rules to interpret
each footage item that you import according to its best guess for the
source file’s pixel aspect ratio, frame rate, colour profile, and alpha
channel type. If After Effects guesses wrong, or if you want to use the
footage differently, you can modify the interpretation of a specific
footage item using the Interpret Footage dialog box.

Fig 1.4 Interpret Footage Dialog
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Create New Folder: You can use this button to create new folder in the
project panel. It is a good practice to store all your objects in separate
folder.
Create New Composition: You can use this button to create new
composition for your project. You can select various options in the new
composition window.
Project Colour Depth: Project Colour Depth displays the colour depth
of the project. You can alt-click on the colour depth to change the depth.
Simply clicking opens project settings where you can change the display
style of the time code, colour settings and audio settings.

Fig 1.5 Project Setting Dialog
Delete Selected Object: This option deletes the selected object from
the project panel. You can also click and drag items to this icon and it
will delete the object.
Panel option Box: This provides you with different option for the project
panel. You can undock panel, close panel, choose which columns to be
displayed in the project panel, project settings etc.
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Fig 1.6 Panel options

1.5 File Menu Options
1.5.1 New Project
The New Project command in File -> New -> New Project creates a new
project which resets the Project panel, before resetting it prompts you
to save the current project. Resetting the Project panel means resetting
all the panels.
1.5.2 New Folder
The New Folder command in File -> New -> New Folder creates new
folder in the project panel. It is a good practice to store all your objects
in separate folder. You can click and drag your footages over the folder
to place those footages in that folder.
1.5.3 Open
The Open command in the File menu provides you with an open dialog
box in which you can browse After Effects’ previously saved project
“.aep” and open that.
1.5.4 Save
The Save command in the File menu provides you with a save as dialog
box for the first time and save the project to the same file afterwards.
1.5.5 Save As
The Save As command in the File Menu provides you always with a save
as dialog box. You can create a duplicate copy of the file. Save As closes
the file you are currently working in and discards any changes made to
the file and saves the file with new name provided by you.
1.5.6 Save A Copy
The Save A Copy command in the File Menu provides you always with a
save as dialog box. You can create a duplicate copy of the file. Save A
Copy save a copy of the file you are currently working in and close the
new file after saving. You continue working in the old file which is not
saved.
1.5.7 Increment and Save
With this command you can automatically save a copy of the file with a
number which increments every time you save with this command while
working on the current project. Choose File > Increment And Save.
1.5.8 Revert
With this command you can take the file to its last saved version.
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1.6 Explaining Composition
A “Composition” is a place where the files that are present in the project
window are placed and animated or composite or given the special effects
to create impossible things.

Fig 1.7 Composition Panel

1.7 New Composition
There are 3 ways to create a new composition:
· Ctrl+N.
· Composition > new composition.
· Create New Composition by clicking the button from the project

window.
The composition settings dialog has following option:
· Composition Name: You can provide a name in the text box. It is a

good practice to give proper names to the assets.
· Basic
o Presets: Here you can set the format for Composition. The frame

rate of the time line is depended on the selection of the format.
Each format has various variants. Available

Formats are:


NTSC


PAL


HDV


DVCPRO
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Cineon


Film


Web
Width and Height: These define the Height and Width of the
composition. Generally these change with the format presets. You can
change the values to create custom size video.

Fig 1.8 New composition settings dialog
1.7.1 NTSC
o Pixel Aspect Ratio o Frame Rate
o Resolution: This sets the resolution of the composition for playback

only. This setting does not affect the rendering.
o Start Timecode: This set the start time of the composition.
o Duration
The full from of NTSC is “National Television Standard Committee”.
This is an American Broadcasting System. The frame rate in here is 29.97
fps. The total fields in here are 60. Inhere there are 525 scale lines.
1.7.2 PAL
The full form of PAL is “Phase Altering line”. This is a European
Broadcasting System. The frame rate in here is 25 fps. Inhere there are
625 scale lines. The total fields in here are 50.
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1.7.3 Pixel Ratios
The pixel aspect ratio should match the ratio of the footage and not that
of the final output.
Format Aspect ratio in pixels
Square Pixels 1.0
D1/DV NTSC 0.91
D1/DV NTSC Widescreen 1.21
D1/DV PAL 1.0966
D1/DV PAL Widescreen 1.462
DVCPRO HD 1.5
HDV 1080 1.33
Anamorphic 2:1 2.0
D4/D16 Standard 0.948
D4/D16 Anamorphic 1.896

Fig 1.9 Pixel Aspect Ratio Dropdown
1.7.4 Frame Rate
This defines the number of the frames played in one second. In After
Effects each composition can have individual frame rate.
1.7.5 Duration
With this option we can easily set the duration of the footage. The duration
of the footage is maintained in SMPTE standard method. The full form
of SMPTE is Society of Motion Pictures and Television Engineers. The
time is displayed in the form of drop frame standard.

1.8 Formats of the files that can be imported
There are different formats that can be imported in After Effects. Let us
have a look over it.
Format
· Adobe Illustrator (.ai, .ai4, .ai5, .eps, .ps)
· Adobe PDF (.pdf)
· Adobe Photoshop (.psd)
· Adobe Premiere 6.0 (.ppj)
· Adobe Premiere 7.0 (.prproj)
· Animated GIF (.gif)
· AU (.au)
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· Audio Interchange File Format AIFF (.aiff)
· Bitmap (.bmp, .rle)
· Cineon (.cin)
· Discreet RLA/RPF (.rla, .rpf)
· ElectricImage (.img, .eiz)
· EPS (.eps
· Filmstrip (.flm)
· FLC (.flc)
· FLI (.fli)
· JPEG (.jpg, jpe)
· Macromedia Flash (.swf)
· Maya camera data
· Maya IFF (.iff)
· MP3 (.mp3)
· MPEG-1 (.mpg)
· PCX (.pcx)
· Pict (.pct, .pic)
· Pixar (.pxr)
· Portable Network Graphics (.png)
· QuickTime (.mov)
· SGI (.sgi, .rgb)
· Softimage (.pic)
· Targa (.tga, .vda, .icb, .vst)
· TIFF (.tif)
· Video for Windows (.avi, .wav)
· Windows Media File (.wmv)
Importing Types
1.8.1 Multi-Layer Photoshop File:
Here we can easily import the file that is made in photoshop layer wise.
All the properties like:
· Position
· Blending mode
· Opacity
· Visibility
· Transparency
· Layer masks
· Layer sets
· Adjustment layers
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· Common layer effects
· Layer clipping paths
· Vector masks
· Image guides
· Clipping groups
1.8.2 Multi-Layer Premier File:
Here we can easily import the file that is made in premier layer wise. All
the properties like:
· A layer
· As a folder containing each clip as an individual footage item.
1.8.3 Transparency
With this we can easily import the file with the transparent background.
The formats which provide us with this facility are
.png
.tga
.tiff
.rpf / .rla

1.9 Quality
The quality can be set in 3 ways of setting the quality of the image layers.
They are
o Best: This provides the quality by checking the sub pixel positioning,

anti-aliasing, 3D shading, and complete calculation of the effects
applied.

o Draft: this produces a very rough quality.
o Wire frame: The layers in here are presented in the form of the

bounding boxes.

1.10Brief explaining of Timeline
You can perform different tasks in the timeline panel like arranging layers
in time, setting blending mode, animating properties etc. Each
composition in After Effects has its own timeline. Timeline panel has
different switches. Current Time Indicator shows the current time of the
composition. Same is shown by the Current- Time Display which is in
the left top corner of the timeline panel
1.10.1 Inserting a file in timeline
We can insert the file in the timeline either by selecting the file in the
project window and place it in timeline window. The other option is select
the file from the project window and click File > Add footage to Comp.
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Fig 1.10 Timeline panel

1.11 Viewing the file in the Composition Panel
To view the file in the composition window drag the file in the timeline
window and double click on the footage in the composition window.

1.12 Showing All options of composition Panel
In the Composition Panel there are buttons which enable or disable
different option.
1.12.1 In-Out Points
This is to set the break in the footage so that we can specify or have a
look at a certain area of the footage.
1.12.2 Snap Shots
This can be used to take a snap of the frame or a sequence so as to get a
reference of that frame over the next frame or after some duration. This
can be used to match the scene at the required frame.
1.12.3 Channels
This option allows us to reveal the data in the form of 3 channels, red,
green, blue and alpha.
1.12.4 Safe Zones
These areas define where the titles and the movie should be placed. This
is used to avoid the over scan.
There are 2 safe zones.
Title Safe
This defines the area or the boundary till where the title should be placed.
Action Safe
This defines the area or the boundary till where the scene should be
placed.

1.13 Summary
Adobe After Effects is a video post-production software which is used
for digital motion graphics and compositing. It is primarily used for
creating visual effects in video production as well as film production. It
supports 2D and 3D work space.
The importance of a composition is like the importance of the heart in
the body. If the arrangement of the elements in the art work is not proper
the idea or message cannot be fulfilled. Before making the thing you
have to decide what you want to generate as the end result of the
composition.
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Majorly there are 2 types of video editing: Offline and Online
o Offline Editing is first done on a lower end editing system and then

the edited data is used on a high end system (the desired system) to
produces the final cut.

o The On-line Editing is entirely done on a high-end system. There
are two more types: Linear and Non-Liner

o In linear editing, the source is played on a player which is connected
to a display terminal (T.V) and a recorder which records the video as
final cut. These days this kind of editing is done when the program,
news, sports or any other kind of video is telecasted at the same
time when it is recorded like we see the live telecast of cricket or
foot ball matches etc. This kind of editing is generally very straight
and simple due to the shortage of time as it is direct telecasted.

o Non-Liner editing is done for movies, serials, interviews, Re-telecast
of a match etc. However here also you have time limits but it gives
a certain amount of time for working on the same project so you
can correct the mistakes even after rendering if needed. It is called
Non-linear because it is not done in a linear fashion i.e. the editor
can place the cuts on the timeline from the same footage and then
later on he can insert, move, clip, trim or do lots of other operations
on the clips.
Adobe After Effects’ interface is divided into different set of Panels
(previously known as windows). There are three major panels:

o Project Panel
o Composition Panel o Timeline Panel

A “Composition” is a place where the files that are present in the
project window are placed and animated or composite or given the
special effects to create impossible things.

The full from of NTSC is “National Television Standard Committee”.
This is an American Broadcasting System. The frame rate in here is 29.97
fps. The total fields in here are 60. Inhere there are 525 scale lines.
The full form of PAL is “Phase Altering line”. This is a European
Broadcasting System. The frame rate in here is 25 fps. Inhere there are
625 scale lines. The total fields in here are 50.
The pixel aspect ratio should match the ratio of the footage and not that
of the final output.
The quality can be set in 3 ways of setting the quality of the image layers.
They are Best, Draft and Wire Frame.
You can perform different tasks in the timeline panel like arranging layers
in time, setting blending mode, animating properties etc. Each
composition in After Effects has its own timeline. Timeline panel has
different switches. Current Time Indicator shows the current time of the
composition. Same is shown by the Current- Time Display which is in
the left top corner of the timeline panel.
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1.14 Self Assessment Test
1. What is Composition and what are their types?

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. What are the different types of Editing?

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

3. Name the major components of After Effects. Explain them briefly.
Write short notes on:
a. Compositing
b. Non-liner Video Editing
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c. NTSC
d. PAL
e. Importable File types

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

1.15. Further reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe
After Effects CS4 Classroom in a Book, Brie Gyncild
Adobe After Effects CS5 Visual Effects and Compositing Studio
Techniques, Mark Christiansen
Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:
Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,
Chad Perkins

1.16 Assignment
Create a new After Effects project, create compositions with varying
settings, import different types of footages and place them in the
composition time line sensibly.
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Learning Objectives:
After reading this unit, you will learn:
 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Understand Flow Charts
 About the Tool Box
 About the functioning of various tools and where they can be used
 About Guides and Grids
 Various commands in Layer, View and Edit Menu
 Functions of various switches in the timeline/layer menu.
 Familiarity with Timeline

: Structure :
2.1 Introduction to the Flowchart
2.2 Tool box

2.2.1 Selection Tool
2.2.2 Hand Tool
2.2.3 Zoom Tool
2.2.4 Rotate Tool
2.2.5 Unified Camera Tool
2.2.6 Orbit Camera Tool
2.2.7 Track XY Camera Tool
2.2.8 Track Z Camera Tool
2.2.9 Pan Behind Tool
2.2.10 Shapes Tool
2.2.11 Pen Tool
2.2.12 Text Tool
2.2.13 Paint Brush Tool
2.2.14 Clone Stamp Tool
2.2.15 Eraser Tool
2.2.16 Puppet pin Tool

2.3 View menu
2.3.1 Guides
2.3.2 Grid
2.3.3 Resolution
2.3.4 Rulers
2.3.5 Go to Time

EXPLAINING TOOL BOXUNIT
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2.4 Align & Distribute
2.5 Edit menu

2.5.1 Undo
2.5.2 Redo
2.5.3 Cut
2.5.4 Copy
2.5.5 Paste
2.5.6 Clear
2.5.7 Select All
2.5.8 Duplicate
2.5.9 Split

2.6 Layer Options in the Timeline
2.6.1 Transform
2.6.2 Anchor point
2.6.3 Position
2.6.4 Scale
2.6.5 Rotation (Tool Box)
2.6.6 Opacity

2.7 Time Line
2.7.1 Creating basic animation (inserting Key frame)
2.7.2 Visibility on/off
2.7.3 Audio on/off
2.7.4 Solo
2.7.5 Lock/unlock

2.8 Layer Menu (Timeline Switches/Options)
2.8.1 Shy
2.8.2 Collapse Transformation
2.8.3 Anti-alias
2.8.4 Frame blending
2.8.5 Motion blur
2.8.6 Arrangement of layer

2.8.6.1 Bring Layer to Front
2.8.6.2 Send to back
2.8.6.3 Bring forward
2.8.6.4 Send backward

2.9 Summary
2.10 Self Assessment Test
2.11 Further reading
2.12 Assignment
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2.1 Introduction to the Flowchart
In the flowchart view for project or composition, individual boxes
represent composition, footage, and layer. Directional arrows represent
the relationships between components.
Note: You cannot use flow chart to change relationships between
elements.

Fig 2.1 Flow Chart View
Mid-gray lines between tiles in the flowchart indicate that the Video or
Audio switch for those items is deselected in the Timeline panel.
Black or light gray lines indicate that the switch is selected, depending
on the Brightness setting in the Appearance preferences.
To select an item, click its tile in the Flowchart panel. When you click a
composition in the flowchart, it becomes active in the Project panel and
the Timeline panel. When you click a layer, it becomes active in the
Timeline panel. When you click a footage item, it becomes active in the
Project panel.
To customize the appearance of the flowchart, use the Flowchart panel
menu and the buttons along the bottom of the panel.
To delete elements, select them and press Delete. If the selected element
is a footage item or composition, it is deleted from the project and no
longer appears in the Timeline and Project panels. If the selected element
is a layer, it is deleted from the composition in which it appears.
2.2 Tool box

Fig 2.2 Tool Box
1. Selection Tool
2. Hand Tool
3. Zoom Tool
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4. Rotate Tool
5. Camera Tools
6. Pan Behind Tool
7. Shape Tools
8. Pen Tools
9. Type Tools
10. Brush Tool
11. Clone Stamp Tool
12. Eraser Tool
13. Puppet Tools
14. Controls related to the current tools
2.2.1 Selection Tool
This tool is used to select the layers in the composition window such as
text, movies, etc. You can select this tool by pressing “V” on the keyboard
(While using keyboard shortcuts make it sure you are not using text
tool).
2.2.2 Hand Tool
This tool is used to Pan/Scroll the Composition as well Timeline panel.
You can select this tool by pressing “H” on the keyboard.
2.2.3 Zoom
This is used to zoom the required area of the composition panel. You can
select this tool by pressing “Z” on the keyboard.
2.2.4 Rotate Tool
This tool is used to rotate the selected layer in the composition window.
You can select this tool by pressing “W” on the keyboard.
2.2.5 Unified Camera Tool
This tool can be used to access various camera tools. With each mouse
button you can access different tool. (You need to use a three button
mouse with this tool and this is available in Adobe After Effects CS 4).
You can select this tool by pressing “C” on the keyboard. Pressing “C”
repeatedly will cycle through the camera tools.
2.2.6 Orbit Camera
This tool is used to orbit the camera around the object or the selected
layer. This tool gets active only when the layer is a 3D layer. You can
select this tool by pressing “C” on the keyboard.
2.2.7 Track XY Camera
The track XY Camera is used to move the camera on the X or Y axis. You
can select this tool by pressing “C” on the keyboard.
2.2.8 Track Z Camera
The track Z Camera is used to move the camera on the X or Y axis. You
can select this tool by pressing “C” on the keyboard.
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2.2.9 Pan Behind Tool
This tool is used to pan a layer behind a mask i.e. to pan a masked layer
behind the mask and not the mask. You can select this tool by pressing
“Y” on the keyboard.
2.2.10 Shapes Tools
This group of tools helps you in drawing different vector shapes. The
group consists of following shapes tools:

Fig 2.3 Shape tools
· Rectangle tool
· Rounded Rectangle tool
· Ellipse tool
· Polygon tool
· Star tool
You can use these tools to create masking on layers. You can select these
tools by pressing “Q” on the keyboard. Pressing ‘Q’ repeatedly will cycle
through these tools.
2.2.11 Pen tools
This group of tools helps you in drawing vector Bezier curves and
modifying these curves using the Bezier handles. The group consists of
following tools:

Fig 2.4 Pen tools
· Pen tool is used for creating curves
· Add Vertex Tool is used for adding more vertex to refine the curves
· Delete Vertex Tool is used to delete extra vertex
· Convert Vertex Tool is used to convert corner vertex to Bezier

vertex.
You can select these tools by pressing “G” on the keyboard. Pressing
‘G’ repeatedly will cycle through these tools.



23

2.2.12 Type Tools
This group of tools helps you in adding text to the composition. The text
is added as a text layer to the composition. There are two types text in
After Effects:
1. Point Text: In Point text each line of text is independent. Point text

doesn’t wraps automatically to next line. Clicking somewhere using
either of the type tool on the composition create point text layer.

2. Paragraph text: In Paragraph text, line automatically wraps to fit
inside the bounding box of the paragraph text. To create a paragraph
text layer, click and drag using any type tool. The area defined by
dragging acts as the bounding box of the paragraph text. Shift + drag
always create a new layer. If you enter text more than the area of the
bounding box then a plus symbol will appear at the bottom right
corner of the bounding box. This symbol is also called as overflow
Icon.

Fig 2.5 Type tools
The properties of the text can be changed using character and paragraph
panels. To end text-editing mode, press Ctrl + Enter. There are two type
tools in the group:

1. Horizontal Type tool
2. Vertical type tool

You can select these tools by pressing “Ctrl + T” on the keyboard. Pressing
‘Ctrl + T’ repeatedly will cycle through these tools.
2.2.13 Brush Tool
This tool is used as a paint brush. The settings of the tool can be changed
from Brushes panel and Paint panel. You can select this tool by press
“Ctrl + B” on the keyboard.
2.2.14 Clone Stamp Tool
This tool is used to copy a portion of the footage and apply to another
portion using brushes. This tool works similar to the clone stamp tool of
Photoshop. The settings of the tool can be changed from Brushes panel
and Paint panel. You can select this tool by press “Ctrl + B” on the keyboard
twice (first time it will select the brush tool.)
2.2.15 Eraser Tool
This tool is used to erase a portion of a layer. The settings of the tool can
be changed from Brushes panel and Paint panel. You can select this tool
by press “Ctrl + B” on the keyboard thrice (First time it will select the
brush tool, second time clone stamp. Repeatedly pressing ‘Ctrl + B’ will
cycle through these three tools).
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2.2.16 Puppet Tools
Use the Puppet tools to quickly add natural motion to raster images and
vector graphics, including still images, shapes, and text characters. Each
Puppet tool is used to place and modify a specific type of pin:
1. Puppet Pin tool: Use this tool to place and move Deform pins.
2. Puppet Overlap tool: Use this tool to place Overlap pins, which

indicate which parts of an image should appear in front of others
when distortion causes parts of the image to overlap one another.

3. Puppet Starch tool: Use this tool to place Starch pins, which stiffen
parts of the image so that they are distorted less.

Fig 2.6 Puppet tools
The Puppet effect works by deforming part of an image according to the
positions of pins that you place and move. These pins define what parts
of the image should move, what parts should remain rigid, and what parts
should be in front when parts overlap. You can select this tool by press
“Ctrl + P” on the keyboard. Repeatedly pressing ‘Ctrl + B’ will cycle
through these tools.

2.3 View menu
2.3.1 Guides

Fig 2.7 Guides in the composition panel
The guides help us to decide the position of the layers all over the
animation.
These are just the references for the layers in the composition window.
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2.3.2 Grids

Fig 2.8 Grid in the composition panel
The grids help us to displays the graph on the composition so that we can
set the layers and snap the objects on the grids.
2.3.3 Resolution
Resolution determines the dimensions of the image in pixels, which
affects the image quality of the rendered composition. The low resolution
increases the speed of the computer.
2.3.4 Rulers
These are the objects which help us to set the layers according to
dimensions that are required by us. These are just the references for the
layers in the composition window.
2.3.5 Go to the time
This helps us to snap the playback head to the defined time.

2.4 Align & Distribute

Fig 2.9 Align & Distribute
The Align palette is used to line up or evenly set the selected layers in
the composition window. Align or distribute tool is used to set layers
along the vertical or horizontal axes of selected objects.
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2.5 Edit menu
2.5.1 Undo
This option is used to go to the last stage of the done action. The keyboard
shortcut is “Ctrl + Z”.
2.5.2 Redo
This option is used to get the back all the undone actions. The keyboard
shortcut is “Ctrl + Shift + Z”.
2.5.3 Cut
This is to “Cut” the selected layer of the object. The keyboard shortcut
is “Ctrl + X”.
2.5.4 Copy
This is used to “Copy” the selected object or the layer. The keyboard
shortcut is “Ctrl + C”.
2.5.5 Paste
This is used to paste the layer or object that is cut or copied. The keyboard
shortcut is “Ctrl + V”.
2.5.6 Clear
This is used to delete the selected layer or the object. The keyboard
shortcut is “Delete”.
2.5.7 Select All
This option is used to select all the layers in the project. The keyboard
shortcut is “Ctrl + A”.
2.5.8 Duplicate
This is used to create the duplicate of the selected layer with all the
properties that is set for the selected layer. The keyboard shortcut is
“Ctrl + D”.
2.5.9 Split
This is used to split the layer at the position of the playback head.

2.6 Layer Options in the Timeline
All the options in the layer in the timeline window help us to manipulate
the layers that help us to animate the layers according to our requirement.
2.6.1 Transform
The transform in the layer options (timeline panel) has all the
transformation option for the layer like position, anchor point, rotation,
scale and opacity. You can change these options as well as you can create
key frames for these options to animate the layer.
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Fig 2.10 Transform group in timeline
2.6.1.1 Anchor Point

Fig 2.11 Anchor Point property of the layer
With this option we can set the anchor point of the selected layer. The
layer transforms (i.e. scale, rotate or move) around the Anchor Point.
Pressing “A” on the keyboard will display only Anchor Point option of
the selected layer(s).
2.6.1.2 Position

Fig 2.12 Position Property of the Layer
With this we can set the position of the layer both when still as well as
when animated. Pressing “P” on the keyboard will display only Position
option of the selected layer(s).
2.6.1.3 Scale

Fig 2.13 Scale Property of the Layer
With this we can set the scale amount of the layer both when still as well
as when animated. Pressing “S” on the keyboard will display only Scale
option of the selected layer(s).
2.6.1.4 Rotation

Fig 2.14 Rotation Property of the Layer
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With this we can set the rotation amount (angle) as well as the number of
rotations for the layer both when still as well as when animated. The first
zero is for the number of rotations (used for animation) and second set
of zeros is for the angle of rotation (mainly used when you want to rotate
the layer at a specific angle). Pressing “R” on the keyboard will display
only Rotation option of the selected layer(s).
2.6.1.5 Opacity

Fig 2.15 Opacity Property of the Layer
With this we can set the opacity amount of the layer both when still as
well as when animated. Pressing “T” on the keyboard will display only
Opacity option of the selected layer(s).

2.7 Timeline
2.7.1. Creating basic animation (inserting Key frame)
In After Effects, if we have to animate any property of the layer, we can
intimate the software of the same by clicking the small stopwatch icon
before the property. The stopwatch should be turned on at the time where
you want to create the first key-frame and then you can create rest of the
key-frames by change the value of the property at different time. Turning
off the stopwatch will remove the key-frames. If you have turned off the
stopwatch then turning it back again will not bring the previous key-frames
back again.

Fig 2.16 Stopwatch and Key-frame in timeline.
2.7.2 Visibility on / off
With this we can set the visibility (Video switch) of the selected layer in
the Composition Panel. Press “Alt + Ctrl + Shift + V” on the key board
to toggle this property.

Fig 2.17 Video Switch in the Timeline Panel
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2.7.3 Audio on / off
With this we can switch On/Off the audio of the selected layer. Audio
switch is available only when there is audio in the layer.

Fig 2.18 Audio switch in the timeline panel
2.7.4 Solo
We can isolate one or more layers in animation, preview or render by
the solo option.

Fig 2.19 Solo Switch in the timeline panel
2.7.5 Lock / Unlock
This is used to lock the layer or to unlock the locked layer. Locking a
layer means the layer and its properties cannot be edited. Press “Ctrl +
L” to lock the selected layer and “Ctrl + Shift + L” to unlock the selected
layer.

Fig 2.20 Lock switch in the Timeline Panel.
2.8 Layer menu (Timeline Switches/Options)
The switches for the layers in the timeline are also accessible from the
layer menu. In this section we will be covering the timeline switches
from the layer menu.
2.8.1 Shy
Making layers shy is useful when we want to make room in the Timeline
window to show the layers and layer properties we want to adjust. Shy
switch control the visibility of the layer in the timeline panel as compare
to the video or solo switch which control its visibility in the composition
panel. We need to turn on the master shy switch (Hide All Layers For
Which Shy is Set) to activate this option.
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Fig 2.21 Shy and Master Shy Switch
2.8.2 Collapse Transformation
When the layer source is a composition or Vector drawing, the Collapse
Transformations switch helps in improving the quality of the same while
animating especially in case of zooming in.

Fig 2.22 Collapse Transformation Switch
2.8.3 Anti alias
With this we can determines the Anti-Alias quality setting for all layer.
You can choose between best and draft. From Layer Menu you can also
sent the Quality to Wireframe along with draft and best.

Fig 2.23 Quality Switch showing layer at Best quality
2.8.4 Frame Blending
This option is used to create blended frames in between existing frames
of the footage. This option is used when you change the speed/duration
of the footage. We need to turn on the master Frame Blending switch to
activate this option.

Fig 2.24 Frame Blending Switch
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2.8.5 Motion Blur
This option is used to set the blur effect in the animation so as to remove
the jerks in the animation. This option works with objects animated in
After Effects (transformation only). We need to turn on the master
Motion Blur switch to activate this option.

Fig 2.25 Motion Blur Switch
2.8.6 Arrangement of layer
With this option we can arrange the layers according to our requirement
in the composition panel.
2.8.6.1 Bring to front
With this we can set the selected layer to the front of all the layers.
2.8.6.2 Send to back
With this we can set the selected layer to the back of all the layers.
2.8.6.3 Bring forward
With this we can bring the selected layer in front of the previous layer.
2.8.6.4 Send backward
With this we can send the selected layer behind of the next layer.

2.9 Summary
In the flowchart view for project or composition, individual boxes
represent composition, footage, and layer. Directional arrows represent
the relationships between components.
You can select selection tool by pressing “V” on the keyboard (While
using
keyboard shortcuts make it sure you are not using text tool).
You can select hand tool by pressing “H” on the keyboard.
You can select zoom tool by pressing “Z” on the keyboard.
You can select rotate tool by pressing “W” on the keyboard.
Pressing “C” repeatedly on the keyboard will cycle through the camera
tools.
You can select Pan Behind tool by pressing “Y” on the keyboard.
Pressing ‘Q’ repeatedly will cycle through Shape tools. Pressing ‘G’
repeatedly will cycle through Pen tools. Pressing ‘Ctrl + T’ repeatedly
will cycle through Type tools. There are two types text in After Effects:
1. Point Text: In Point text each line of text is independent. Point text

doesn’t wraps automatically to next line.
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2. Paragraph text: In Paragraph text, line automatically wraps to fit
inside the bounding box of the paragraph text.

You can select Brush tool by press “Ctrl + B” on the keyboard.
You can select Clone Stamp tool by press “Ctrl + B” on the keyboard
twice.
You can select Eraser tool by press “Ctrl + B” on the keyboard thrice.
Use the Puppet tools to quickly add natural motion to raster images and
vector graphics, including still images, shapes, and text characters.
Repeatedly pressing ‘Ctrl + B’ will cycle through these tools.
The Align palette is used to line up or evenly set the selected layers in
the composition window. Align or distribute tool is used to set layers
along the vertical or horizontal axes of selected objects.
Pressing “A” on the keyboard will display only Anchor Point option of
the selected layer(s).
Pressing “P” on the keyboard will display only Position option of the
selected layer(s).
Pressing “S” on the keyboard will display only Scale option of the selected
layer(s).
Pressing “R” on the keyboard will display only Rotation option of the
selected layer(s).
Pressing “T” on the keyboard will display only Opacity option of the
selected layer(s).
To animate any property in After Effects, we can press the stop watch
icon to start recording the changes we make to the property. Enabling
the stopwatch creates Key Frame at the current poistion of the Playback
Head.

2.10 Self Assessment Test
4. What is the use of stop watch icon?

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................
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..........................................................................

..........................................................................

5. What is the shortcut for Orbit Camera tool, Brush tool and Puppet
Pin tool?

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

6. What are options to hide a layer in Composition panel and the
Timeline panel?

Write Short notes on:
a. Puppet pin Tool
b. Align & Distribute Panel
c. Anchor Point
d. Solo switch
e. Shy switch
f. Frame Blending

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................
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..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2.11 Further reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe
After Effects CS4 Classroom in a Book, Brie Gyncild
Adobe After Effects CS5 Visual Effects and Compositing Studio
Techniques, Mark Christiansen
Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:
Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,
Chad Perkins

2.12 Assignment
Import some images and place them in the timeline, then animate these
images to create some meaningful animation.
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Learning Objectives:
After reading this unit, you will learn:
· About Masking
· How Masking is done and various uses of masking
· Nested Compositions and its uses
· Various type of Layer options like Blending, Time remapping,

etc.

: Structure :
3.1. Introduction to Layer Menu

3.1.1.New Solid
3.1.2.Adjustment Layer
3.1.3.Text
3.1.4.Null Object

3.2. Color Key
3.2.1.Transfer mode (working with different layer)

3.3. Nested Composition
3.4. Masking
3.5. Guide layers
3.6. Preserve Transparency
3.7. Blending Modes

3.7.1. Normal Category
3.7.1.1. Normal
3.7.1.2. Dissolve
3.7.1.3. Dancing Dissolve
3.7.2. Subtractive Category
3.7.2.1. Darken
3.7.2.2. Multiply
3.7.2.3. Color Burn
3.7.2.4. Classic Color Burn
3.7.2.5. Liner Burn
3.7.2.6. Darker Color
3.7.3. Additive Category
3.7.3.1. Add
3.7.3.2. Lighten

LAYER MENU, NESTED
COMPOSITION AND MASKING

UNIT
3
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3.7.3.3. Screen
3.7.3.4. Color Dodge
3.7.3.5. Classic Color Dodge
3.7.3.6. Linear Dodge
3.7.3.7. Lighter Color

3.7.4. Complex Category
3.7.4.1. Overlay
3.7.4.2. Soft Light
3.7.4.3. Hard light
3.7.4.4. Liner Light
3.7.4.5. Vivid Light
3.7.4.6. Pin Light
3.7.4.7. Hard Mix

3.7.5. Difference Category
3.7.5.1. Difference
3.7.5.2. Classic Difference
3.7.5.3. Exclusion

3.7.6. HSL Category
3.7.6.1. Hue
3.7.6.2. Saturation
3.7.6.3. Color
3.7.6.4. Luminosity

3.7.7. Matte Category
3.7.7.1. Stencil Alpha
3.7.7.2. Stencil Luma
3.7.7.3. Silhouette Alpha
3.7.7.4. Silhouette Luma

3.7.8. Utility Category
3.7.8.1. Alpha Add
3.7.8.2. Luminescent Premul

3.8. Summery
3.9. Self Assessment Test
3.10. Further Reading
3.11. Assignment

3.1 Introduction to Layer Menu
Layer Menu is one of the most important menus in the After Effects.
After Effects treats all imported files as Layers whether it is video
footage, an image or sound file. All the options in this menu are used to
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set the layer or to use the layers according to our requirement. These
options are related to various properties (like position, rotation, scale,
etc.), switches (like visibility, solo, shy, quality, etc.), blending modes
(like dissolve, darken, multiply, screen, colour dodge, add, overlay etc.),
masking and time controls (like time reverse, time stretch, time
remapping, etc.) of the layers in the timeline. Few of these options are
available in the timeline panel also.
3.1.1 New Solid
The solid layer is used to create a colourful background as well as for
masking. The maximum size can be set up to 30,000 x 30,000. This can
be also used for creating the simple motion graphics.

Fig 3.1 New Solid Layer dialog
3.1.2 Adjustment Layer
This is exactly like the adjustment layer in Photoshop. When the effect
is applied to the adjustment layer all the layers below that are affected
by the applied effects.
3.1.3 Text
The Text layer is used to write text in the composition. We can add text
layer from the Layer Menu. A text layer will be automatically added when
you click with text tool in the composition panel.
3.1.4 Null Object
The Null Object Layer is used as a transparent layer. We can use null
object for adding secondary transformation to layer(s). For adding
secondary transformations use Parent switch in the Timeline Panel.
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Fig 3.2 Parent Switch

3.2 Effects Menu
The effect menu in After Effects helps us in applying the filters and the
special effects to the layers.
3.2.1 Basic Text
Using the Basic Text effect, we can create text and text animation. We
can specify font, style, and alignment of text, as well as select horizontal
or vertical text orientation. Animation is created by changing the
Properties of text over time.

Fig 3.3 various properties of text which can be animated
3.2.2 Color Key
The Color Key effect keys out all image pixels that are similar to a
specified key colour. This effect modifies only the alpha channel of a
layer. The layer’s quality setting does not affect Color Key.

Fig 3.4 Use of color key effect
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3.3 Nested Composition
If we add one composition to another, the original composition becomes
a layer in the parent composition. All the nested composition’s compo-
sition-time markers become layer-time markers in the Timeline win-
dow of the parent composition. These markers are not linked to the origi-
nal composition-time markers: Changes we make to the composition-
time markers in the original composition do not affect layer-time mark-
ers in the nested composition. For example, if we remove one of the
original composition-time markers, the corresponding layer-time marker
for the nested composition remains in place.
The Advanced tab of the Composition Settings dialog box includes two
nesting options. If the Preserve Resolution When Nested option is
selected, the nested composition retains its resolution setting. If this
option is not selected, the containing composition’s resolution overrides
the nested composition’s resolution. We can use the Preserve Resolution
option, for example, to retain a low resolution for a nested composition
and improve its preview time. When selected, the Preserve Frame Rate
When Nested or in Render Queue option locks a composition to a
specific frame rate, which should improve performance in many cases
as well as eliminate the need to use Posterize Time in creating reduced
frame rate effects. If this option is not selected, the containing
composition’s frame rate overrides the nested composition’s frame rate.
For example, say if we have to composite computer generated (CG)
footage with a live footage. The CG footage is of a Wasp and is of 5
frames in which it is flapping its wings and the live footage is of a person
which is of 2 seconds. In such a case we need to duplicate the CG footage
to match the duration of the live footage. But duplicating will make things
more complex, as now if we have to animate the CG footage then we
have to individually animate all of them. To remove this problem we can
put the CG footage into a separate composition and then we can add that
composition to our main composition. The composition with
CG footage will become nested composition and will appear as one single
layer which can be then easily animated.

Fig 3.5 Composition with duplicated CG Footage.
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Fig 3.6 CG Footages in separate Composition “Wasp”

Fig 3.7 Composition “Wasp” used in the main
composition as a layer

3.4 Masking
Masking specifies the pixels we want to change using the luminance or
alpha channel of another layer. Mask Layer specifies the layer we want
to use for mask. Masking Mode specifies the Mask Layer property to
use. With this we can reveal the data that is only required either by
applying matte or alpha. In After Effects, Masks are drawn on layers
using either shape tools or pen tool. When you create a Mask for the
web site, mask options appears in the layer options above transform
properties. More options can be found in the Layer Menu.

Fig 3.8 Masking options in the timeline panel
Mask Path Color: You can change the color of the mask path by clicking
on the color swatch on the left of the mask name and choose a color
from the color picker. This helps you in identifying and work with
different masks. By default, all masks appear in yellow colour.
Mask Mode: From the drop down list you can select the mask mode.
Following options are available in the drop down list:
None: When ‘None’ is selected, Mask will not have any effect on the
layer’s alpha channel
Add: When ‘Add’ is selected, only the area enclosed by the mask will be
visible. The effect of the mask is collective with the masks above it.
o Subtract: When ‘Subtract’ is selected, the area surrounded by the mask
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will be invisible/hidden. This option is useful when we want to create the
appearance of a hole in another mask.
o Intersect: When ‘Intersect’ mode is selected, the areas where the mask
overlays the masks above it there the effect of the mask is collective
with the masks above it. In areas where the mask does not overlays with
the masks above it, the area will be invisible/ hidden.
o Lighten: In ‘lighten’ mode the areas where multiple masks overlap,
the highest transparency value is used.
o Darken: In ‘Darken’ mode the areas where multiple masks overlap,
the lowest transparency value is used.
o Difference: In ‘Difference’ mode, areas where the mask does not
overlays the masks above it there the mask works as it would be alone on
the layer. In areas where the mask overlays the masks above it there the
effect of the mask is subtracted from the masks above it.

Fig 3.9 Masking modes in the timeline panel
Inverted: If this option is on (ticked), then the mask mode will have
inverted effect.
Mask Path: The mask path allows you to animate the mask shape. You
can turn on the stop watch of the mask path and either change the position
of the vertices or change the entire shape using the change shape dialog
to animate the mask path. In the change shape dialog, you can change the
bounding box of the masks path as well as you can change the shape to
rectangle or ellipse. The mask path is animated for rotoscoping.
Mask Feather: This option softens the edges of a mask by fading it
from more transparent to less transparent over defined distance.
Mask Opacity: Mask Opacity affects the opacity of the alpha channel
and not that of the layer.
Mask Expansion: Mask expansion affects the alpha channel but not the
underlying mask path; the mask expansion is essentially an offset that
determines how far, in pixels, from the mask path the influence of the
mask on the alpha channel extends.

3.5 Guide layers
We can change existing layers into guide layers to use them as references
in the Composition panel, so that it help us to position and edit elements.
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When we change a layer to guide layer, an icon appears next to the name
of a guide layer or its source in the Timeline panel.
By default, guide layers are not rendered but can be rendered when desired
by changing the render settings.
Note: Guide layers in nested compositions cannot be viewed in the
containing composition.

3.6 Preserve Transparency
Preserve Transparency ensures that the alpha channel of the original layer
is not modified.

3.7 Blending Modes
Blending modes in Layer Menu control how each layer blends with layers
beneath it. Blending modes in After Effects are identical to blending
modes in Photoshop. Most blending modes change only colour values
of the source layer, not the alpha channel. The ‘Alpha Add’ does affect
the alpha channel of the source layer, and the silhouette and stencil
blending modes affect the alpha channels of layers beneath them. ‘Normal’
is the default blending mode all layers.
The blending modes are sectioned into eight categories based on
similarities between their results. The categories are simply separated
by lines in between them in the menu.
3.7.1 Normal category
The result colour of a pixel is not affected by the colour of the underlying
pixel unless Opacity is less than 100% for the source layer.
3.7.1.1 Normal
The result of this blending mode is the source colour. Normal is the
default blending mode.
3.7.1.2 Dissolve
The result of this blending mode for each pixel is either the source colour
or the underlying colour. The chance that the result colour is the source
colour differs with the opacity of the source. Dissolve does not affect
3D layers.
3.7.1.3 Dancing Dissolve
The result of this blending mode is similar to Dancing Dissolve. The
only difference is that it calculates the dissolve for each frame.
3.7.2 Subtractive category
These blending modes tend to darken colours, by mixing colours in much
the similar way as mixing coloured pigments in paint.
3.7.2.1 Darken
The result of this mode is that each colour channel value of the result is
of the lower value than of the source colour channel value.
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3.7.2.2 Multiply
This blending mode multiplies colour value of each channel of the source
layer with underlying colour channel value and then divides it by maximum
value of either 8-bpc or 16-bpc or 32-bpc, depending on the colour depth
of the project. This ensures that result colour of multiply blending is
never brighter than the original. If one of the colour pixel is black then
the result is black (any number multiplied by zero is zero) and if it is
white then the result is the other colour (any number multiplied by one
remains same).
3.7.2.3 Color Burn
In this blending mode the result is a darkened colour of the source colour
to reflect the underlying layer colour by increasing its contrast.
3.7.2.4 Classic Color Burn
If you want to bring or take the After Effects project to version 5.0 or
previous then you can use this blending mode. The output of this is same
as Color Burn.
3.7.2.5 Linear Burn
In this blending mode, the result is a darkened colour of the source colour
to reflect the underlying colour.
3.7.2.6 Darker Color
The Darker Color is similar to Darken. The only difference is that it
works on colour pixel as a whole and not on individual channels.
3.7.3 Additive category
These blending modes tend to lighten colours, some by mixing colours
in much the same way as mixing projected light.
3.7.3.1 Add
In this Blending mode, result colour channel’s value is the sum of the
colour channel values of the source colour and underlying colour.
3.7.3.2 Lighten
In this blending mode, the result colour value of each channel is lighter
than that of the source colour channel and the underlying colour channel.
3.7.3.3 Screen
This blending mode multiplies the round out of the channel values of
source and underlying colours. Using the Screen mode is similar to
projecting multiple slides simultaneously onto a single screen.
3.7.3.4 Color Dodge
In this blending mode, the result is a lightened colour of the source colour
to reflect the underlying colour by decreasing the contrast.
3.7.3.5 Classic Color Dodge
If you want to bring or take the After Effects project to version 5.0 or
previous then you can use this blending mode. The output of this is same
as Color Dodge.
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3.7.3.6 Linear Dodge
In this blending mode, the result is a lightened colour of the source colour
to reveal the underlying colour by increasing the brightness.
3.7.3.7 Lighter Color
The Lighter Color is similar to Lighten. The only difference is that it
works on colour pixel as a whole and not on individual channels.
3.7.4 Complex category
These blending modes perform different operations on the source and
underlying colours depending on whether one of the colours is lighter
than 50% gray.
3.7.4.1 Overlay
This blending mode multiplies or screens the input colour channel values
to produce the result, depends upon the underlying colour whether it is
lighter than 50% gray or not. It preserves the highlights and the shadows
in the underlying layer.
3.7.4.2 Soft Light
This blending mode darkens or lightens the channel values of the
underlying layer, based on the source colour. A layer with pure black or
white becomes significantly darker or lighter, but does not become pure
black or white.
3.7.4.3 Hard Light
This blending mode multiplies or screens the input colour channel values
to produce the result, depending on the original source colour. This mode
is generally used for creating the appearance of shadows.
3.7.4.4 Linear Light
This blending mode burns or dodges the colours by increasing or
decreasing the brightness, based on the lower layer.
3.7.4.5 Vivid Light
This blending mode burns or dodges the colours by increasing or
decreasing the contrast, depending on the lower layer.
3.7.4.6 Pin Light
In this blending mode, if the main colour is lighter than 50% gray, pixels
darker than the main colour are replaced, and pixels lighter than the main
colour do not change and vice a versa.
3.7.4.7 Hard Mix
This blending mode improves the contrast of the layer that is visible
beneath a mask on the source layer. The mask size determines the
contrasted area.
3.7.5 Difference category
These blending modes create colours based on the differences between
the values of the source colour and the underlying colour.
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3.7.5.1 Difference
This blending mode subtracts the darker values from the lighter values
for each channel. Black colour produces no change. This blending mode
is also useful if you are joining/aligning two parts of an image as the
pixels with same value will become black.
3.7.5.2 Classic Difference
If you want to bring or take the After Effects project to version 5.0 or
previous then you can use this blending mode. The output of this is same
as Difference.
3.7.5.3 Exclusion
The result of this blending mode is similar to the Difference mode but it
is lower in contrast than Difference mode.
3.7.6 Hue Saturation Luminosity category
These blending modes transfer one or more of the components of the
HSL representation of colour (hue, saturation, and luminosity) from the
underlying colour to the result colour.
3.7.6.1 Hue
The result of this blending mode has luminosity and saturation of the
underlying layer, and the hue of the source layer.
3.7.6.2 Saturation
The result of this blending mode has luminosity and hue of the underlying
layer, and the saturation of the source layer.
3.7.6.3 Color
The result of this blending mode has luminosity of the underlying layer
and hue and saturation of the source layer. This is useful for colouring
gray scale images and for tinting colour images.
3.7.6.4 Luminosity
The result of this blending mode has hue and saturation of the underlying
layer, and luminosity of the source layer. This mode is the reverse of the
Color blending mode.
3.7.7 Matte category
These blending modes basically convert the source layer into a matte
for all underlying layers. The stencil and silhouette blending modes use
the alpha channel or the luma (luminance) values of the layer to affect
the alpha channel of all layers beneath that layer.
3.7.7.1 Stencil Alpha
This blending mode creates a cutout (stencil) using the alpha channel of
the source layer.
3.7.7.2 Stencil Luma
This blending mode creates a cutout (stencil) using the luminous values
of the source layer. The lighter pixel the more opaque they are.
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3.7.7.3 Silhouette Alpha
This blending mode creates an outline (silhouette) using the alpha channel
of the source layer.
3.7.7.4 Silhouette Luma
This blending mode creates an outline (silhouette) using the luminous
values of the source layer. Black colour produces no results.
3.7.8 Utility category
These blending modes have specialized functions.
3.7.8.1 Alpha Add
Normally the Alpha channel of two layers is multiplied which causes
seams in certain parts of the layers where they are touching each other.
To solve this problem you can use Alpha Add blending mode, it solves
the problem of seams by adding the alpha channels instead of multiplying
them.
3.7.8.2 Luminescent Premul.
It prevents the clipping of the colour values which exceeds the alpha
channel values in that layer.

3.8 Summary
After Effects treats all imported files as Layers whether it is video
footage, an image or sound file. All the options in this menu are used to
set the layer or to use the layers according to our requirement.
The solid layer is used to create a colourful background as well as for
masking. The maximum size can be set up to 30,000 x 30,000.
The Null Object Layer is used as a transparent layer. We can use null
object for adding secondary transformation to layer(s).
The Colour Key effect keys out all image pixels that are similar to a
specified key colour. This effect modifies only the alpha channel of a
layer.
If we add one composition to another, the original composition becomes
a layer in the parent composition. All the nested composition’s
composition-time markers become layer-time markers in the Timeline
window of the parent composition.
Masking specifies the pixels we want to change using the luminance or
alpha channel of another layer. Mask Layer specifies the layer we want
to use for mask. Masking Mode specifies the Mask Layer property to
use. With this we can reveal the data that is only required either by
applying matte or alpha.
We can change existing layers into guide layers to use them as references
in the Composition panel, so that it help us to position and edit elements.
Blending modes in Layer Menu control how each layer blends with layers
beneath it. Blending modes in After Effects are identical to blending
modes in Photoshop. Most blending modes change only colour values
of the source layer, not the alpha channel.
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3.9 Self Assessment Test
1. What is nesting of compositions?

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. What is masking? Explain different modes of masking?

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

3. What are the different blending mode categories available in After
Effects?

Write short notes on:
a. Adjustment Layer
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b. Null Object
c. Color Key
d. Preserve transparency
e. Subtractive blending modes

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

3.10 Further Reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe
After Effects CS4 Classroom in a Book, Brie Gyncild
Adobe After Effects CS5 Visual Effects and Compositing Studio
Techniques, Mark Christiansen
Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:
Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,
Chad Perkins

3.11 Assignment
Import some images and place them in the timeline, then change their
blending modes to see the effects of blending modes.
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ROLE OF SELF INSTRUCTIONAL MATERIAL

IN DISTANCE LEARNING

The need to plan effective instruction is imperative for a suc-

cessful distance teaching repertoire. This is due to the fact that the in-

structional designer, the tutor, the author (s) and the student are often

separated by distance and may never meet in person. This is an increas-

ingly common scenario in distance education instruction. As much as

possible, teaching by distance should stimulate the student’s intellectual

involvement and contain all the necessary learning instructional activi-

ties that are capable of guiding the student through the course objec-

tives. Therefore, the course / self-instructional material are completely

equipped with everything that the syllabus prescribes.

To ensure effective instruction, a number of instructional design

ideas are used and these help students to acquire knowledge, intellectual

skills, motor skills and necessary attitudinal changes. In this respect,

students’ assessment and course evaluation are incorporated in the text.

The nature of instructional activities used in distance education

self- instructional materials depends on the domain of learning that they

reinforce in the text, that is, the cognitive, psychomotor and affective.

These are further interpreted in the acquisition of knowledge, intellec-

tual skills and motor skills. Students may be encouraged to gain, apply

and communicate (orally or in writing) the knowledge acquired. Intel-

lectual- skills objectives may be met by designing instructions that make

use of students’ prior knowledge and experiences in the discourse as the

foundation on which newly acquired knowledge is built.

The provision of exercises in the form of assignments, projects

and tutorial feedback is necessary. Instructional activities that teach motor

skills need to be graphically demonstrated and the correct practices pro-
vided during tutorials. Instructional activities for inculcating change in

attitude and behavior should create interest and demonstrate need and

benefits gained by adopting the required change. Information on the adop-

tion and procedures for practice of new attitudes may then be intro-

duced.



Teaching and learning at a distance eliminates interactive com-

munication cues, such as pauses, intonation and gestures, associated with

the face-to-face method of teaching. This is particularly so with the ex-

clusive use of print media. Instructional activities built into the instruc-

tional repertoire provide this missing interaction between the student

and the teacher. Therefore, the use of instructional activities to affect

better distance teaching is not optional, but mandatory.

Our team of successful writers and authors has tried to reduce

this.

Divide and to bring this Self Instructional Material as the best

teaching and communication tool. Instructional activities are varied in

order to assess the different facets of the domains of learning.

Distance education teaching repertoire involves extensive use of

self- instructional materials, be they print or otherwise. These materials

are designed to achieve certain pre-determined learning outcomes,

namely goals and objectives that are contained in an instructional plan.

Since the teaching process is affected over a distance, there is need to

ensure that students actively participate in their learning by performing

specific tasks that help them to understand the relevant concepts. There-

fore, a set of exercises is built into the teaching repertoire in order to

link what students and tutors do in the framework of the course outline.

These could be in the form of students’ assignments, a research project

or a science practical exercise. Examples of instructional activities in

distance education are too numerous to list. Instructional activities, when

used in this context, help to motivate students, guide and measure stu-

dents’ performance (continuous assessment)



PREFACE

We have put in lots of hard work to make this book as user-friendly

as possible, but we have not sacrificed quality. Experts were involved in

preparing the materials. However, concepts are explained in easy

language for you. We have included many tables and examples for easy

understanding.

We sincerely hope this book will help you in every way you

expect.

All the best for your studies from our team!
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Block 1 INTRODUCTION

UNIT 1 INTRODUCTION TO COMPOSTING
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Composition
 Types of Compositions
 Video Editing
 Types of Editing
 Video Broadcasting Standards
 After Effects Interface
 Importing files in After Effects
 Creating New, Opening and Saving compositions
 Familiarity with Timeline

UNIT 2 EXPLAINING TOOL BOX
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Understand Flow Charts
 About the Tool Box
 About the functioning of various tools and where they can be

used
 About Guides and Grids
 Various commands in Layer, View and Edit Menu
 Functions of various switches in the timeline/layer menu.
 Familiarity with Timeline

UNIT 3 LAYER NESTED COMPOSITION  AND MASKING
Learning Objectives:

 About Masking
 How Masking is done and various uses of masking
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.

Block 2: ANIMATION AND EFFECTS
UNIT 1 ANIMATION
Learning Objectives:

 How to do Animation in After Effects
 How to increase or decrease the speed of the footage
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.
UNIT 2 EFFECTS
Learning Objectives:

 Various Effects available in After Effects



 Use of Blur and Sharpen Effects
 Use of 3D Effects
 Use of Channel
 Use of Colour Correction

UNIT 3 SOME MORE EFFECTS
Learning Objectives:

 Various Effects available in After Effects
 Use of Render Effects
 Use of Stylize Effects
 Use of Text Effects
 Use of Audio

Block 3 ADVANCED KEYING,MATTE AND ANIMATION
TECHNIQUE

UNIT 1 KEYING AND MATTE
Learning Objectives:

 Learning about advanced Keying
 Learning about advanced matte

UNIT 2 ADVANCED ANIMATION TECHNIQUES
Learning Objective

 Learning about animation techniques
 Learning Motion Tracking
 Learning Stabilizing
 Learning Motion Sketching

Block 4 3D AND RENDERING IN AE
UNIT 1 3D MOTION IN AFTER EFFECTS
Learning Objective

 Learning about 3D in After Effects
 Learning use of 2D layers in 3D World
 Learning about 3D layer options and transformation Properties
 Learning 3D compositions of position, rotation, shadow,

reflection and other effects by examples
UNIT 2 RENDERING
Learning Objective

 Learning to make Textures for Different Creatures
 Learning to make Textures for Cat, Rat, Lion, Reptiles, Birds,

Fishes, Turtles, Mammals, Wild Animals, Pets, Etc
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ANIMATIONUNIT
1

Learning Objectives:
After reading this unit, you will learn:

· How to do Animation in After Effects
· How to increase or decrease the speed of the footage
· Nested Compositions and its uses
· Various type of Layer options like Blending, Time remapping, etc.

: Structure :
1.1 Introduction to Animation in After Effects
1.2 Basic Animation creation using transformation
1.3 Manipulating speed
1.4 Advance animation concept

1.4.1.Toggle hold key frame
1.4.2.Key frame interpolation
1.4.3.Key frame velocity
1.4.4.Easing in & out
1.4.5.Reversing animation.

1.5 Show options like
1.5.1.Time Stretch
1.5.2.Time re mapping

1.6 Linking layer
1.6.1.Transformation using linking

1.7. Summary
1.8. Self Assessment Test
1.9. Further Reading
1.10. Assignment

1.1 Introduction to Animation
After Effects is a compositing, motion graphics and animation software.
Animating an object (layer) is simple in After Effects. Most of the layer
options, effects, masks and sound properties can be animated in After
Effects like you can animate scale, position, rotation, opacity etc. of the
layer to create various effects. To animate an option turn on the stopwatch
(toggle button) in front of that option and the option can be animated by
changing the values at different frames. If you want to remove the
animation for that option, just turn of the stopwatch.
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1.2 Basic Animation Using Transformations in Timeline
Every  video  or image  layer  in After  Effect  has  transformations
properties.
Transform properties include:
1. Anchor Point: Transformations like rotation and scale, happens

around a transformation center called as the anchor point of the
layer.

2. Position: The positioning of the layer in the composition in x and y
axis is determined by the position property of the layer.

3. Scale: The width and height of the layer can be controlled by the
scale property of the layer. The scale is defined in percentage.
Generally the width and height scale percentage are locked so that it
scales proportionally. To unlock the height and width, simply click
on the chain icon near the scale property. After Effect’s workspace
behaves as infinite which means that you can scale a layer beyond
the composition’s width and height and the region beyond that will
still be maintained so that you can scale them down at any time. You
can also use the scaling to flip a layer by scaling that layer in the
negative direction.

4. Rotation: The rotation of a layer happens around the anchor point
of the layer. The rotation of layer has two values. The first part
controls the number of whole rotations a layer will make and second
part controls the fractional rotation in degrees (0-359).

5. Opacity: The opacity property of the layer controls how opaque or
transparent the layer is. A value of 100 means layer is totally opaque
and a value of 0 means layer is totally transparent, and any value in
between will result in a translucent layer. The opacity works on both
the contents of the layer as well as the layer effects applied on it.

1.3 Manipulating Speed
In animation speed plays a very important role. Speed of footage can add
various effects and meanings to the video. Speed option helps us to
manipulate the speed according to our requirement. When you increase
the speed the duration of the video shortens as After Effect will be playing
the same number of frames faster which will reduce the total duration
and when you decrease the speed the duration of the video increases.

1.4.  Advance Animation Concept
1.4.1 Toggle hold key frame
A keyframe icon uses one interpolation method, but we can apply two
methods:
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Fig 1.1 Toggle Hold Keyframe
· The incoming method applies to the property value as the current

time approaches a keyframe,
· The outgoing method applies to the property value as the current

time leaves a keyframe.
There are 2 types of interpolation
· Bezier
· Linear
So to apply or remove Hold interpolation as outgoing interpolation this
option is used.
1.4.2. Key frame interpolation
The Keyframe Interpolation dialog box provides options for setting
temporal and spatial interpolation and, for spatial properties only, roving
settings.

Fig 1.2 Keyframe Interpolation Dialog
1.4.3 Key frame velocity
We can control the values approaching and leaving a keyframe together,
or we can control each value separately. The incoming handle increases
the speed or velocity when we drag it up and decreases the speed or
velocity when we drag it down. The outgoing handle influences the next
keyframe in the same way. We can also control the influence of the speed
or velocity by dragging the handles left or right.
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Fig 1.3 Showing the animation curve and velocity
This can be used:
· To adjust the incoming and outgoing rate changes together.
· To fine-tune speed separately for incoming and outgoing frames.
· To rejoin split direction handles.
1.4.1 Easing In and Out
With this we can eliminate sudden changes in a property’s speed by using
the Easy Ease keyframe assistant. Although we can manually adjust the
speed of a keyframe by dragging direction handles, using Easy Ease
automates the work.

Fig 1.4 displaying Eased In keyframe 1.4.5 Reversing animation
We can easily reverse a layer’s playback direction. When we do, all
Keyframes for all properties on the selected layer also reverse position
relative to the layer. The layer itself maintains its original In and Out
points relative to the composition. For best results, replace the layer
with a composition that has the same frame size as the layer, and reverse
the layer inside the composition. This is the most accurate way to reverse
footage.

1.5.  Show options like
1.5.1 Time stretch
When we time-stretch a layer, the audio file or the original frames in the
footage are redistributed along the new duration. Use this command only
when we want the layer and all layer Keyframes to change to the new
duration. Time-stretching a layer redistributes Keyframes along the new
duration. If we time-stretch a layer so that the resulting frame rate is
significantly different from the original speed, the quality of motion
within the layer may suffer. Turn on frame blending to improve slow-
motion or fast-motion effects.
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Fig 1.5 Time stretch Dialog Box
1.5.2 Time re-mapping
We can time-remap an entire layer, making it play backwards. We can
time-remap a few frames at the beginning or end of the layer, creating a
freeze-frame effect. Or we can time-remap frames in the middle of the
layer, creating a slow-motion effect. We can remap time for video footage
only; still images cannot be remapped. For best results, do not remap
video footage that has been time-stretched. You can time remap using
the keyframes. You can add key frames and change their values to create
various effects related to the time.

Fig 1.6 Time Remap Option in the timeline

1.6 Linking layer
Use expressions to link objects successively and at precisely the same
interval. This expression is useful for creating a concussion appearance,
in which objects appear at a set interval and successively scale up and
replace each other. To link to layer use the drop down under the parent
heading in the time line. In the drop down parent option of the layer
which you want to be influenced by the other layer, choose the name of
the layer which will influence this layer and then the current layer will
be influenced by the selected layer.
1.6.1 Transformation using link
Position
We can use expressions to position objects successively and at precisely
the same interval. This expression is useful for creating a concussion
appearance, in which objects appear at a set interval and successively
scale up and replace each other.
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Rotation
We can use expressions to rotation objects successively and at precisely
the same interval. This expression is useful for creating a concussion
appearance, in which objects appear at a set interval and successively
scale up and replace each other.
Scale
We can use expressions to scale objects successively and at precisely
the same interval. This expression is useful for creating a concussion
appearance, in which objects appear at a set interval and successively
scale up and replace each other.

Fig 1.7 Showing a linked layer.

1.7 Summary
After Effects is a compositing, motion graphics and animation software.
Animating an object (layer) is simple in After Effects. Most of the layer
options, effects, masks and sound properties can be animated in After
Effects like you can animate scale, position, rotation, opacity etc. of the
layer to create various effects. To animate an option turn on the stopwatch
(toggle button) in front of that option and the option can be animated by
changing the values at different frames.
Every video or image layer in After Effect has transformations properties
which can be easily animated to create motion graphics. Transform
properties include:

· Anchor Point
· Position
· Scale
· Rotation
· Opacity

In animation speed plays a very important role. Speed of footage can add
various effects and meanings to the video. Speed option helps us to
manipulate the speed according to our requirement. When you increase
the speed the duration of the video shortens as After Effect will be playing
the same number of frames faster which will reduce the total duration
and when you decrease the speed the duration of the video increases.
For more control over animation following can be used:
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· Toggle hold key frame
· Key frame interpolation
· Key frame velocity
· Easing In and Out
· Time Stretch
· Time remapping
· Linking or Parenting Layers

1.8 Self Assessment Test
1. What is animation? Define principals of animation

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. What are the various transformations you can animate? Write in detail

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................
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..........................................................................

3. Write detail about time re mapping and time stretching
Write Short notes on:

a. Time stretching and frame blending
b. Manipulating the key frames
c. Linking layers
d. Easing in and out
e. Keyframe velocity

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

1.9 Further Reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe
After Effects CS1 Classroom in a Book, Brie Gyncild
Adobe After Effects CS5 Visual Effects and Compositing Studio
Techniques, Mark Christiansen
Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:
Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,
Chad Perkins

1.10 Assignment
Create a simple motion graphic animation using still images and footages.
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Learning Objectives:
After reading this unit, you will learn:
· Various Effects available in After Effects
· Use of Blur and Sharpen Effects
· Use of 3D Effects
· Use of Channel
· Use of Colour Correction

: Structure :
2.1 Introduction to Effects
2.2 Color correction
2.3 Blur & Sharpen
2.4 3d effects
2.5 Distortion
2.6 Vector Paint
2.7 Perspective
2.8 Channel
2.9 Exercise
2.10 Summery
2.11 Self Assessment Test
2.12 Further Reading
2.13 Assignment

2.1 Introduction to Effects
Effects can be defined as the power to produce some results. In After
effects, there are various effects which are categorized according to the
kind results they produce or on the basis of operation or the properties
they work on. You can also get more effects into After Effect by installing
3rd party plugins or software. In this chapter you will learn about the
color correction, blur & sharpen, 3D Effects, Channel, distortion, Image
control and Perspective effects categories.

2.2 Color Correction
This set of effects contains options which are used for making color
corrections and effects through color corrections as per the requirement
in the video.
Hue/Saturation:
Hue: Hue is the shift in the color based on the wavelength or angle of
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the refraction of the color color. Hue is measured in angle so it ranges
from -180 to 0 to 180.
Saturation: Saturation is the intensity of the color, vividness of the Hue.
In simple words Saturation is the purity of the color. The more pure the
color is the more saturate it is. Unsaturated colors become a shade of
gray of the same intensity.

Fig 2.1 Controls for Hue/Saturation Effect
Color Change:
With color change effect you can select a color to change and then
you can use Hue, Saturation and Lightness values to change the to a
desired color.

Fig 2.2 Controls for Change Color Effect
Change to Color:
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Change to color effects changes a picked color into other picked color.
You can select tolerance of the color based on hue, saturation and
lightness to be changed.

Fig 2.3 Controls for Change to Color Effect
Color Balance:
The Color Balance (HLS) effect alters an image’s levels of hue, lightness,
and saturation. It is intended only to provide compatibility with projects
created in earlier versions of After Effects that use the Color Balance
(HLS) effect.

Fig 2.4 Controls for Color Balance Effect
Color Link:
The Color Link effect colorizes one layer with the average pixel values
of another selected layer.
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Fig 2.5 Controls for Color Link Effects
Equalize:
The Equalize effect alters an image’s pixel values to produce a more
consistent brightness or color component distribution.
Gamma/pedestal/gain:
The Gamma/Pedestal/Gain effect adjusts the response curve
independently for each channel.

Fig 2.6 Controls for GPG Effect
Colorama:
The Colorama effect assigns a custom palette to an element in a layer
and then cycles the palette. You can define the input phase to decide what
colorama should take as input and in output cycle you can define the
color and the cycle of the color to be filled.
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Fig 2.7 Controls for Colorama Effect
Tint:
The Tint effect alters an image’s color information.

Fig 2.8 Controls for Tint
Tritone:
Tritone fills the image’s highlight, midtones and shadows with the
specified colors. You can fill a lighter shade of the same color or different
in the highlights or bright areas of the selected layer and darker color or
different color in the shadows or dark areas of the layer.

Fig 2.9 Controls for Tritone Effect.
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2.3 Blur & Sharpen
Box Blur :
The Box Blur effect blurs an image based on the average color value of
neighboring pixels. We can adjust the size of the area that the effect uses
to calculate the average value for a given pixel; a larger radius makes the
image blurrier.

Fig 2.10 Output and Controls of Box blur Effect
Channel Blur effect
The Channel Blur effect blurs a layer’s red, green, blue, or alpha channels
individually. We can specify that the blur is horizontal, vertical, or both.
At Best quality, the blur is smooth. Use this effect for glow effects or if
we want a blur that does not become transparent near the edges of the
layer. Edge Behavior describes how to treat the edges of a blurred image.
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Fig 2.11 Output and Controls for Channel Blur Effect
Compound Blur effect:
The Compound Blur effect blurs pixels in the selected layer based on
the luminance values of a blur layer, also known as a blurring map. The
blur layer, which can be any layer that contains pixels of different
luminance values, is essentially overlaid on top of the selected layer,
and the pixels of both layers are matched, one to one.
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Fig 2.12 Output and controls for Compound Blur Effect
Directional Blur effect:
The Directional Blur effect gives a layer the illusion of motion. In
previous versions of After Effects, this effect was called Motion Blur.
At Draft quality, the effect is a blur of the image in which each pixel is
the outweighed average of its adjacent pixels. At Best quality, the effect
uses Gaussian weighting, producing a smoother, more graduated blur.
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Fig 2.13 Output and controls of Direction blur effect
Fast Blur effect:
The Fast Blur effect blurs an image. Specify whether the blur is horizontal,
vertical, or both. At Best quality, the Fast Blur effect is a close
approximation of a Gaussian Blur, but it blurs large areas more quickly.
Gaussian Blur effect:
The Gaussian Blur effect blurs and softens the image and can reduce
noise. Specify whether the blur is horizontal, vertical, or both.
Radial Blur effect:
The Radial Blur effect creates blurs around a specific point in a layer,
simulating the effects of a zooming or rotating camera.
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Fig 2.14 Output and controls of Radial blur effect.
2.4 3D effects
All the effects in this panel can be used to apply the 3d effects to the
selected layer.
3d channel extracts:
The 3D Channel Extract effect makes auxiliary channels visible as either
grayscale or multi-channel colour images. We can then use the resulting
layer as parameters for other effects.
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Fig 2.12 Output and controls for 3D Channel Extract Effect
Depth Matte:
The Depth Matte effect reads the z-depth information in a 3D channel
image file and can slice the image anywhere along that z axis. Use this
effect to create a matte for everything in front of or behind the value we
specify.
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Fig 2.16 Output and controls for Depth Matte Effect
Depth of Field:
The Depth of Field effect simulates a camera that’s focusing in on one
area in a 3D scene (along the z axis) while allowing other areas to blur.
Fog 3d:
The Fog 3D effect applies fog along the z axis, so the distant parts of a
3D scene look hazier or disappear behind the fog. Fog 3D simulates fog
by behaving as though there is a scattering medium in the air that makes
objects look more and more diffuse as they get more distant along the z
axis.
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Fig 2.17 Output and Controls of 3D Fog Effect
ID Matte:
The ID Matte effect isolates elements in a 3D channel image file. This
information to create a matte that excludes everything in the scene except
the element we want. Identify each object’s Object ID by applying the ID
Matte effect and then clicking different parts of the image in the
Composition window as we watch the Info palette.
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Fig 2.18 Output and controls of ID Matte Effect
2.5 Distortion
Bezier Warp:
The Bezier Warp effect shapes an image using a closed Bezier curve
along the boundary of a layer.

Fig 2.19 Output and controls for Bezier Warp Effect
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Bulge:
The Bulge effect distorts an image around a specified point, making the
image appear to bulge toward or away from the viewer,
Adobe After Effects Self Instructional Material depending on the
options we select.

Fig 2.20 Output and controls of Bulge Effect
Corner pin:
The Corner Pin effect distorts an image by repositioning each of its four
corners. Use it to stretch, shrink, skew, or twist an image or to simulate
perspective or movement that pivots from the edge of a layer, such as a
door opening.
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Fig 2.21 Output and controls for Corner Pin Effect
Displacement map:
The Displacement Map effect distorts a layer by displacing pixels
horizontally and vertically based on the color values of pixels in a second
layer, called the displacement map.
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Fig 2.22 Output and controls of Displacement Map
Effect applied on text.

Liquify:
The Liquify effect lets we push, pull, rotate, enlarge and shrink areas in a
layer. Several Liquify tools distort the brush area when we hold down the
mouse button or drag. The distortion is concentrated at the center of the
brush area, and the effect intensifies as we press and hold the mouse
button down. Some of the tools are: Warp, Turbulence, Twirl Clockwise,
Twirl Counter Clockwise, Pucker, Bloat, Shift Pixels, Reflection, Clone,
and Reconstruction (these are in the same order from left to right in the
effect control panel). These effects behave same as Photoshop liquefy
effect.
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Fig 2.23 Output and controls of Liquify Effect.
Magnify:
The Magnify effect enlarges a selected area of a layer. This effect acts
like you are watching the layer from a magnifying glass. You can use
magnify to scale image without effecting its resolution.
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Fig 2.24 output and controls of magnify effect
Mesh Warp:
The Mesh Warp effect applies a grid of Bezier patches (squares in the
grid) over a layer, which we can manipulate to distort areas of an image.
Each corner of a patch includes a vertex and two to four tangents.
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Fig 2.22 Output and controls for Mesh Warp Effect
Mirror:
The Mirror effect splits the image along a line and reflects one side
onto the other.

Fig 2.26 Output and controls of Mirror Effect
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Offset:
The Offset effect pans the image within a layer. The empty area after
panning is filled by the area of the layer which is knocked out of the
other side.

Fig 2.27 Output and controls of Offset Effect
Optics Compensation:
Use the Optics Compensation effect to add or remove camera lens
distortion.

Fig 2.28 Output and controls of Optics compensation
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Polar co-ordinate:
The Polar Coordinates effect distorts a layer by transposing each pixel
in the layer’s x,y coordinate system to the corresponding position in the
polar coordinate system, or the reverse.
Ripple:
The Ripple effect creates the appearance of ripples in a specified layer,
moving away from a center point in concentric circles.

Fig 2.29 Output and controls of Ripple Effect
Smear:
Using the Smear effect, we define an area within an image and then move
that area to a new location, stretching, or smearing, the surrounding part
of the image with it.
Spherize:
The Spherize effect distorts a layer by wrapping a region of the image
onto a spherical shape of variable size.
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Fig 2.30 Output and Controls of Spherize Effect.
Transform:
The Transform effect applies 2D geometric transformations to the source
layer.
Turbulent displace:
The Turbulent Displace effect uses fractal noise to create turbulent
distortions in an image.
Twirl:
The Twirl effect twirls the pixels of an image around a specified point at
a specified amount. Pixels nearer the center point are twirled faster than
pixels in outer regions, resulting in a whirlpool appearance.
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Fig 2.31 Output and controls of Twirl Effect
Warp:
Use Warp to distort or deform After Effects layers.
Wave warp:
The Wave Warp effect produces the appearance of a wave traveling across
an image.

2.6 Vector Paint
Vector Paint strokes are made up of many tiny points that create the
stroke path, you can affect them using Vector Paint features such as
smoothing and wiggling. These strokes are non-destructive, so painting
and erasing actions affect only the appearances on a layer; they don’t
alter the original source file of any image on the layer. When you select
vector paint effect in effect control window, a separate tool palate for
the vector paint appears on the screen.
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Fig 2.32 Output and Controls for Vector Paint Effect

2.7 Perspective
Bevel Alpha:
It bevels the layer based on the alpha channel of the same layer, which
gives a 3D kind of effect to a 2D element. If the layer is opaque that is
the alpha channel is completely white then the borders of the layer gets
the bevel effect.
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Fig 2.33 Output of Bevel Alpha Effect on Text
Bevel Edge:
Bevel Edge works somewhat similar to the Bevel Alpha, the major
difference is that it only bevels the edge of the layer even if the layer has
an alpha channel.

Fig 2.34 Output and controls for Bevel Edge Effects
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Drop Shadow:
Drop shadow effect adds a shadow to the layer which appears behind the
layer. The shape of the layer is decided by the alpha channel of the layer.

Fig 2.32 Output and controls of Drop Shadow effect
2.8 Channel
Invert:
Invert effect inverts the color channel information of a layer. It inverts
white to black, red to cyan, green to magenta, blue to yellow and vise a
versa.
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Fig 2.36 Output and controls for Invert Effect
Set Channels:
Set Channels copies the channels of the source layer to the channels of
the target layer. Using this you can add or change a channel of the layer
for example you can use a red channel of one layer as an alpha channel
for the other layer.

Fig 2.37 Output and controls for Set Channels Effect
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2.9 Exercise
Creating an Ocean in After Effects
Here’s a simple way to create a convincing animated ocean scene using
After Effects.
Open up After Effects and create a new composition. Set it to the PAL
DV preset, but if you’d like to pan and zoom over your footage, make it
a bit bigger (keeping in mind this will bump up your render times). Name
the comp “base”- it is always good practice to name your comps so you
don’t get confused later.

Fig 2.38 New composition settings
Create a new solid which is wider and a bit taller than your comp - 2000
x 600, around three times comp width. You can choose any color at this
moment.
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Fig 2.39 New Layer settings

Apply Fractal Noise. First we create the greater variations in the water
surface - we’ll be adding smaller waves in a moment. Under the Transform
tab, turn Uniform Scaling off and scale the width up and the height down.
Drop the contrast a bit. You should end up with something like this:
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Fig 2.40 Fractal Noise’s controls and output
Now apply Corner Pin to create perspective. Move the top two corners
until they meet the edges of the comp.

Fig 2.41 After applying Corner Pin Effect
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This gives us a nice base for the water texture. Now we’ll create the
smaller waves. Duplicate the layer and adjust the new layer’s fractal noise
settings to create much finer noise. Scale the width and height down, and
bump up the complexity.
Set the new layer’s blending mode to Linear Light and drop its opacity to
20%. You should be looking at something like this:

Fig 2.42 After duplicating and changing the blending mode
Animate the water by setting Evolution keyframes. The top layer should
evolve faster than the bottom layer. I set the top layer to evolve 6 rotations
over 10 seconds, and the bottom layer to evolve 2 rotations. Experiment
and preview the animation until it looks right. The more slowly the water
evolves, the more distant it will appear.
Now we have a nice moving base for our ocean. From this point we can
create any number of different versions of the ocean, simulating many
atmospheric and weather effects. For our purposes right now, we’ll set
our scene at midday under a sunny sky. Create a new comp and call it
“ocean”. Drag “base” into this comp. No w create a new solid and line up
its top edge so it exactly covers the water texture.

Fig 2.43 New Layer added to the Ocean Composition
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This layer will be our color base, an d base will provide the texture.
Create a Ramp and drag the End of Ra mp point up to the bottom of the
visible frame. Set the end color to a dark, deep blue with a little bit of
green. The startt color should be a sligh tly lighter variation.

Fig 2.44 Ramp applied to the new layer
Now place this layer underneath b a se and set base’s blending mode to
Multiply and opacity to 20%.

Fig 2.42 After changing the blending mode
Duplicate the base layer and apply Levels roughly, Gaussian blur this
layer about 2 pixels and drop its opacity to 22%.
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Fig 2.46 After applying Levels and Gaussian Blur
Now is a good time to bring in a sky so you can better determine what
the ocean should look like. Place the sky as the lowest layer and scale to
fit.

Fig 2.47 After adding the sky
We’re getting there, but the ocean still looks flat and unconvincing. Let’s
add some foam for added realism. Duplicate the base layer again and
bring it to the top. Set its transfer mode to Screen. Set Levels to cut out
all but the brightest portions. This will take a lot of tweaking, and will
vary based on your fractal noise settings. Play with it until you get
something you like.

Fig 2.48 After changing the levels to create Foam
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Fig 2.49 Level effect for Foam
Play the animation to see how things are looking motion-wise. I found
that slowing the speed of the foam layer to 20% made for more realistic
motion.
You also may want to blur the foam layer slightly. This can be tricky,
because if you blur it too much the foam look like reflected sunlight.
But it can also add to the illusion of distance. It’s up to you.
This foam was good enough, although they tend to bunch together with
this method and look kind of like floating ice. For a more realistic look,
it might be worthwhile to bring in a new fractal noise comp with smaller,
more evenly spaced noise.
Create a new comp called “horizon” and a gray solid. Scale it down
vertically. Don’t worry about the exact size.

Fig 2.20 The layer for Horizon
Bring the horizon comp into ocean, line it up with the horizon line, drop
its opacity to around 60%, and blur it about 22 pixels. This will pull the
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edges in a bit from either side, so scale it up horizontally until it stretches
out of frame. Adjust the Hue/Saturation until the haze matches the color
of the sky where it meets the ocean.

Fig 2.21 The layer for Horizon applied in the Ocean Comp
The horizon line is still a bit too sharp, so duplicate the horizon layer and
drop the blur to around 12 pixels.

Fig 2.22 Final Ocean composition
Now we just add a little noise and play with the levels if necessary.

2.10 Summary
In this unit you learned about various effects and their uses. All the effects
in After Effect are divided into various categories based on common
outputs or elements which they affect. You have learned following
categories and effects:
1. Color Correction: The effects in this category works on the color

values of the image and are generally used to do color correction in
the layer. In earlier versions of After effects, these effects were
also known as Image Control Effects. Following are some of the
effects in this category:
a. Hue/Saturation
b. Color Change
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c. Change To Color
d. Color Balance
e. Color Link
f. Equalize
g. Gama/Pedestal/Gain
h. Colorama
i. Tint
j. Tritone

2. Blur & Sharpen: The effects in this category either mix the pixels
to blur the image or separate the pixels to sharpen the image.
Following are the effects in this category:
a. Box Blur
b. Channel Blur
c. Compound Blur
d. Directional Blur
e. Fast Blur
f. Gaussian Blur
g. Radial Blur

3. 3D Effects: These effects apply on images with z-buffer or depth
i.e. RLA or .RFP images. Some of these effects are:
a. 3D Channel extract
b. Depth Matte
c. Depth of Field
d. Fog 3d
e. ID Matte

4. Distortion: These effects distort the image in one way or the other.
Some distorts based on color values, some on alpha channel, some
based on predefined algorithm and some take values from other
layers. Some of these are:
a. Bezier Warp
b. Bulge
c. Corner pin
d. Displacement Map
e. Liquify
f. Magnify
g. Mesh Warp
h. Mirror
i. Offset
j. Optics Compensation
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k. Smear
l. Spherize
m.Transform
n. Turbulent Displace
o. Twirl
p. Warp
q. Wave Warp

5. Perspective: These give layer a bit of perspective or 3D looks.
Some of the effects are:
a. Bevel alpha
b. Bevel Edge
c. Drop Shadow

6. Channel: These effects work on the channels of the image. You can
invert channels, mix, multiply or add channels of one layer or two
layers. Some of the effects in this category are:
a. Invert
b. Set Channels

2.11 Self Assessment Test
1. What are the various Color Correction Effects? Explain each one

of them.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. What are the various Channel Effects? Explain each one of them.

..........................................................................
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..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

3. What are the various Distortion Effects? Explain each one of them.
Write short note on the following:
a) Gama/Pedestal/Gain Effect.
b) Radial Blur Effect.
c) ID Matte Effect.
d) Liquify Effect.
e) Displacement Map Effect.
f) Set Channels.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................
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2.12 Further Reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe
After Effects CS4 Classroom in a Book, Brie Gyncild
Adobe After Effects CS2 Visual Effects and Compositing Studio
Techniques, Mark Christiansen
Adobe After Effects CS2 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 2th Edition, Fifth Edition:
Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,
Chad Perkins

2.13 Assignment
Using the above effects try to enhance the colors of a video footage with
poor colors or colorize a black and white video.
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Learning Objectives:
After reading this unit you should be able to know:
· Various Effects available in After Effects
· Use of Render Effects
· Use of Stylize Effects
· Use of Text Effects
· Use of Audio

: Structure :
3.1 Introduction of Effects
3.2 Render
3.3 Simulation
3.4 Stylize
3.5 Text
3.6 Audio
3.7 Summery
3.8 Self Assessment Test
3.9 Further Reading
3.10 Assignment

3.1 Introduction to Effects
Effects can be defined as the power to produce some results. In After
effects, there are various effects which are categorized according to the
kind results they produce or on the basis of operation or the properties
they work on. You can also get more effects into After Effect by installing
3rd party plugins or software. In this chapter you will learn about the
Render, Simulation, Stylize, Text, Time, Video and Audio effects
categories.

3.2 Render
· 4-Colour Gradient : The 4-Colour Gradient effect produces a four-

colour gradient. Each colour is controlled by one of four individual
effect points, which can be animated.

· Advance lighting: The Advanced Lightning effect creates
simulations of electrical discharges. It is self animated.

· Beam: The Beam effect animates the movement of a laser beam.
· Cell pattern: The Cell Pattern effect generates cellular patterns

based on cellular noise.

SOME MORE EFFECTSUNIT
3



50

· Checker board: The Checkerboard effect creates a checkerboard
pattern

· Circle: The Circle effect creates either a customizable solid circle
or ring

· Ellipse: The Ellipse effect draws an ellipse based on the dimensions
we specify in the Effect Controls window.

· Eye Dropper fill: The Eyedropper Fill effect applies a sampled
color to the source layer.

· Fill: The Fill effect is used to fill a mask with a specified color.
· Fractal: The Fractal effect renders the Mandelbrot or Julia set,

creating colorful textures.
· Grid: We can use the Grid effect to create a customizable grid.
· Lens Flare: The Lens Flare effect simulates the refraction caused

by shining a bright light into the camera lens.
· Lighting: The Lightning effect creates lightning bolts and other

electrical effects.
· Paint Bucket: The Paint Bucket effect is a non-destructive paint

tool that fills a selected area with a solid color.
· Radio Waves: The Radio Waves effect creates radiating waves from

a stationary or animated effect point.
· Ramp: The Ramp effect creates a colour gradient, blending it with

the original image contents.
· Scribble: The Scribble effect creates a hand-drawn artwork

appearance by replacing a closed mask shape with strokes.
· Stroke: The Stroke effect creates a stroke or border around a mask

or along a Bezier path.
· Vegas: The Vegas effect generates running lights and other path-

based pulse animations around an object.

3.3 Simulate:
· Card Dance: This effect creates the appearance of card

choreography by segmenting layers into numerous cards and then
controlling all geometric aspects of the cards by using a second
layer.

· Caustics: This effect simulates caustics-reflections of light at the
bottom of a body of water, created by light refracting through the
water’s surface.

· Foam: The Foam effect is available from the Adobe Web site
(www.adobe.com) after we register were copy of After Effects. This
effect generates bubbles that flow, cling, and pop.

· Particle Playground: The Particle Playground effect lets we
animate a large number of similar objects independently, such as a
swarm of bees or a snow storm.
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· Shatter: The Shatter effect explodes graphic images. Use the effect’s
controls to set explosion points and adjust the strength and radius.

· Wave World: We can use this effect to create a grayscale
displacement map for use with other effects such as Colourama or
Caustics. This effect creates physics-based liquid waves.

3.4 Stylize:
· Brush Strokes : The Brush Strokes effect applies a rough painted

look to an image.
· Colour emboss: The Colour Emboss effect works like the Emboss

effect, without suppressing the image’s original colours.
· Emboss: The Emboss effect sharpens the edges of objects in the

image and suppresses colours.
· Find Edges: The Find Edges effect identifies the areas of the image

that have significant transitions and emphasizes the edges.
· Glow: The Glow effect finds the brighter parts of an image and

then brightens those and surrounding pixels to create a diffuse,
glowing halo.

· Leave Colour : The Leave Colour effect removes all the colours
from a layer except those similar to a given colour.

· Mosaic: The Mosaic effect fills a layer with solid colour rectangles.
It is useful for simulating low-resolution displays and for obscuring
faces.

· Motion Tile: The Motion Tile effect replicates the source image
across the output image. It is called Motion Tile because, when
changing the placement of the tiles, it uses motion blur to accentuate
the movement if motion blur is enabled.

· Roughen Edges: The Roughen Edges effect roughs up the edges of
a layer’s alpha channel by using calculations.

· Scatter: The Scatter effect scatters the pixels in a layer, creating a
blurry or smeared appearance.

· Strobe light: The Strobe Light effect performs an arithmetic
operation on a layer at periodic or random intervals.

· Texturize: The Texturize effect gives a layer the appearance of having
the texture of another layer.

· Write on: The Write-on effect animates strokes on a layer.

3.5 Text
· Basic text: Using the Basic Text effect, we can create text and text

animation. We can specify font, style, and alignment of text, as well
as select horizontal or vertical text orientation. Animation is created
by changing the Position point over time. Basic Text also gives us
the choice of either compositing the text over the layer image or
using the text by itself. Best quality creates anti-aliased text that
animates smoothly.
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· Number text
The Numbers effect generates random and sequential numbers in
different formats. We can use it to display random times and dates
or timecodes, or to print the current date and time on a layer
whenever it’s rendered.

· Path text:
The Path Text effect lets we animate text along a path. We can define
a path as a straight line, a circle of any diameter, or a Bezier curve.
We can also import a path created in another application, such as
Adobe Photoshop or Adobe Illustrator. The Path Text effect works
with non-square pixels, adjusting both character shape and path shape
accordingly.

3.6 Audio
Audio effects work on audio. When you scribe through the After Effects
timeline, audio does not play. To play audio placed on the timeline along
with the video, use RAM Preview option. After effects is compositing
software that is the reason why audio effects are not much supported by
it. You can use backwards, Bass & treble, Delay, Flange & Chorus, High-
Low pass, Reverb, Stereo Mix effects on the audio in the After Effects.

3.7 Summery
In this unit you learned about various effects and their uses. All the effects
in After Effect are divided into various categories based on common
outputs or elements which they affect. You have learned following
categories and effects:
1. Render: In new versions of After Effects is called as Generate, The

effects in this category are used to create new elements. Some of
the effects are:
a. 4-Color Gradient.
b. Advance Lighting.
c. Beam.
d. Cell Pattern
e. Checker Board
f. Circle
g. Ellipse
h. Eye Dropper Fill
i. Fill
j. Fractal
k. Grid
l. Lens Flare
m.Lightening
n. Paint Bucket
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o. Radio Waves
p. Ramp
q. Scribble
r. Stroke
s. Vegas

2. Simulate: These are special kind of effects. These effects use
fundamentals of physics and simulate real life like properties like
gravity, friction, collision etc. Some of the effects in this category
are:
a. Card Dance
b. Caustics
c. Foam
d. Particle Playground
e. Shatter
f. Wave World

3. Stylize: These effects are used to enhance the color or other qualities
of the layers. Some of the effects in this category are:
a. Brush Strokes
b. Color Emboss
c. Emboss
d. Find Edges
e. Glow
f. Leave Color
g. Mosaic
h. Motion Tile
i. Roughen Edges
j. Scatter
k. Strobe Light
l. Texturize
m.Write On

4. Text: These effects work with the text. You can do a lot of things
with the text. After Effects also have some presets for text effects
too. Following are the text effects:
a. Basic Text
b. Number
c. Path Text
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3.8 Self Assessment Test
1. What are the various Simulation Effects? Explain each one of them.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. What are the various Render? Explain each one of them.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

3. What are the various Stylize? Explain each one of them.
Write short note on the following:

a) Advance Lighting Effect.
b) Fractal Effect.
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c) Vegas Effect.
d) Shatter Effect.
e) Particle Playground Effect.
f) Write on effect.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

3.9 Further Reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe
After Effects CS4 Classroom in a Book, Brie Gyncild
Adobe After Effects CS5 Visual Effects and Compositing Studio
Techniques, Mark Christiansen
Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:
Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,
Chad Perkins

3.10 Assignment
Using the above effects try to simulate shattering of a layer.
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ROLE OF SELF INSTRUCTIONAL MATERIAL

IN DISTANCE LEARNING

The need to plan effective instruction is imperative for a suc-

cessful distance teaching repertoire. This is due to the fact that the in-

structional designer, the tutor, the author (s) and the student are often

separated by distance and may never meet in person. This is an increas-

ingly common scenario in distance education instruction. As much as

possible, teaching by distance should stimulate the student’s intellectual

involvement and contain all the necessary learning instructional activi-

ties that are capable of guiding the student through the course objec-

tives. Therefore, the course / self-instructional material are completely

equipped with everything that the syllabus prescribes.

To ensure effective instruction, a number of instructional design

ideas are used and these help students to acquire knowledge, intellectual

skills, motor skills and necessary attitudinal changes. In this respect,

students’ assessment and course evaluation are incorporated in the text.

The nature of instructional activities used in distance education

self- instructional materials depends on the domain of learning that they

reinforce in the text, that is, the cognitive, psychomotor and affective.

These are further interpreted in the acquisition of knowledge, intellec-

tual skills and motor skills. Students may be encouraged to gain, apply

and communicate (orally or in writing) the knowledge acquired. Intel-

lectual- skills objectives may be met by designing instructions that make

use of students’ prior knowledge and experiences in the discourse as the

foundation on which newly acquired knowledge is built.

The provision of exercises in the form of assignments, projects

and tutorial feedback is necessary. Instructional activities that teach motor

skills need to be graphically demonstrated and the correct practices pro-
vided during tutorials. Instructional activities for inculcating change in

attitude and behavior should create interest and demonstrate need and

benefits gained by adopting the required change. Information on the adop-

tion and procedures for practice of new attitudes may then be intro-

duced.



Teaching and learning at a distance eliminates interactive com-

munication cues, such as pauses, intonation and gestures, associated with

the face-to-face method of teaching. This is particularly so with the ex-

clusive use of print media. Instructional activities built into the instruc-

tional repertoire provide this missing interaction between the student

and the teacher. Therefore, the use of instructional activities to affect

better distance teaching is not optional, but mandatory.

Our team of successful writers and authors has tried to reduce

this.

Divide and to bring this Self Instructional Material as the best

teaching and communication tool. Instructional activities are varied in

order to assess the different facets of the domains of learning.

Distance education teaching repertoire involves extensive use of

self- instructional materials, be they print or otherwise. These materials

are designed to achieve certain pre-determined learning outcomes,

namely goals and objectives that are contained in an instructional plan.

Since the teaching process is affected over a distance, there is need to

ensure that students actively participate in their learning by performing

specific tasks that help them to understand the relevant concepts. There-

fore, a set of exercises is built into the teaching repertoire in order to

link what students and tutors do in the framework of the course outline.

These could be in the form of students’ assignments, a research project

or a science practical exercise. Examples of instructional activities in

distance education are too numerous to list. Instructional activities, when

used in this context, help to motivate students, guide and measure stu-

dents’ performance (continuous assessment)



PREFACE

We have put in lots of hard work to make this book as user-friendly

as possible, but we have not sacrificed quality. Experts were involved in

preparing the materials. However, concepts are explained in easy

language for you. We have included many tables and examples for easy

understanding.

We sincerely hope this book will help you in every way you

expect.

All the best for your studies from our team!



MOTION GRAPHICS (Software-Adobe After Effects)

Block 1 INTRODUCTION

UNIT 1 INTRODUCTION TO COMPOSTING
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Composition
 Types of Compositions
 Video Editing
 Types of Editing
 Video Broadcasting Standards
 After Effects Interface
 Importing files in After Effects
 Creating New, Opening and Saving compositions
 Familiarity with Timeline

UNIT 2 EXPLAINING TOOL BOX
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Understand Flow Charts
 About the Tool Box
 About the functioning of various tools and where they can be

used
 About Guides and Grids
 Various commands in Layer, View and Edit Menu
 Functions of various switches in the timeline/layer menu.
 Familiarity with Timeline

UNIT 3 LAYER NESTED COMPOSITION  AND MASKING
Learning Objectives:

 About Masking
 How Masking is done and various uses of masking
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.

Block 2: ANIMATION AND EFFECTS
UNIT 1 ANIMATION
Learning Objectives:

 How to do Animation in After Effects
 How to increase or decrease the speed of the footage
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.
UNIT 2 EFFECTS
Learning Objectives:

 Various Effects available in After Effects



 Use of Blur and Sharpen Effects
 Use of 3D Effects
 Use of Channel
 Use of Colour Correction

UNIT 3 SOME MORE EFFECTS
Learning Objectives:

 Various Effects available in After Effects
 Use of Render Effects
 Use of Stylize Effects
 Use of Text Effects
 Use of Audio

Block 3 ADVANCED KEYING,MATTE AND ANIMATION
TECHNIQUE

UNIT 1 KEYING AND MATTE
Learning Objectives:

 Learning about advanced Keying
 Learning about advanced matte

UNIT 2 ADVANCED ANIMATION TECHNIQUES
Learning Objective

 Learning about animation techniques
 Learning Motion Tracking
 Learning Stabilizing
 Learning Motion Sketching

Block 4 3D AND RENDERING IN AE
UNIT 1 3D MOTION IN AFTER EFFECTS
Learning Objective

 Learning about 3D in After Effects
 Learning use of 2D layers in 3D World
 Learning about 3D layer options and transformation Properties
 Learning 3D compositions of position, rotation, shadow,

reflection and other effects by examples
UNIT 2 RENDERING
Learning Objective

 Learning to make Textures for Different Creatures
 Learning to make Textures for Cat, Rat, Lion, Reptiles, Birds,

Fishes, Turtles, Mammals, Wild Animals, Pets, Etc
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KEYING & MATTING
UNIT

1

Learning Objectives:

After reading this unit, you will learn:

· Learning about advanced keying

· Learning about advanced matting

: Structure :

1.1  Introduction

1.2  Advance keying and matting options

1.3  Summery

1.4  Self Assessment Test

1.5  Further Reading

1.6  Assignment

1.1 Introduction

In this Unit you will learn to make and use advance keying and matting.

We will discuss about the options available in these two for detailed

study of them. You will learn to make visual effects as keying matting

are parts of Visual Effects which are generally used in movies and serials

we see.

1.2 Advance keying and matting options

Let’s see all keying options available in After Effects. You can get these

keying options in Effects as shown in the following figure.
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Fig. 1.1: Keying Options

1. Color Difference Key Effect: The Color Difference Key effect

creates transparency from opposite starting points by dividing an

image into two mattes, Matte Partial A and Matte Partial B. Matte

Partial B bases the transparency on the specified key color, and Matte

Partial A bases transparency on areas of the image that do not contain

a second, different color.

Fig. 1.2: Color Difference Key

In this effect you will get various options for selecting any color’s

range and then you can remove it from the video.

In the preview options available here, you will get picker for

selecting a range of color directly by clicking in the preview option’s

right side view box. You can even add or remove any color range

with the other 2 pickers available here.
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Fig. 1.3: Color Difference Key Preview

There are following options available for working in Color

Difference Key effect as following:

1. View: Here you can decide that which type of view you want in

the preview from the given options like shown in the following

figure.

Fig. 1.4: Color Difference Key View types

2. Key Color: Here you can select the color that you want to remove

as a key color with the help of color box or color picker.

3. Color Matching Accuracy: Here you can decide how much

accurate selection you want to use for removing the color. Options

available here are Faster and More accurate.

Several more options are available here for selecting and removing

color from a video and they are – Partial A in Black, Partial A in

White, Partial A in Gamma, Partial A Out Black, Partial A Out

White, Partial B in Black, Partial B in White, Partial B in Gamma,

Partial B Out Black, Partial B Out White, Matte In Black, Matte

In White and Matte In Gamma. These all are useful for selecting

particular color and its proper range.

2. Color Key: The Color Key effect keys out all image pixels that are

similar to a specified key color. This effect modifies only the alpha

channel of a layer.
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Fig. 1.5: Color Key Options

Here you will get following options for corrections in selection of

a color for removal of the same.

1. Key Color: This is used for selecting a color from the video for

removal with the use of color picker or Key Color box.

2. Color Tolerance: This is used for increasing or decreasing the

color selection strength in the effect so you can adjust the color’s

selection range as per your requirement.

3. Edge Thin: This is use to sharpen the edges of removed color.

4. Edge Feather: this is used for making feather edges on the

objects’ edges after once the color is removed from the video.

3. Color Range effect: The Color Range effect creates transparency

by keying out a specified range of colors in the Lab, YUV, or RGB

color space.

Fig. 1.6: Color Range Effect

1. Preview: Here you will get preview options where you can select

any color from the video and add or remove any color from the

selected color’s range.
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2. Fuzziness: here you can increase or decrease the strength of color

selection.

3. Color Space: Here you can decide which kind of color space

you want to consider for making selection of the color for

removal of the same. The options available here are – Lab, YUV

and RGB.

There are several options available to modify and change the

selection like – Min (L, Y, R), Max (L, Y, R), Min (a, U, G), Max

(a, U, G), Min (b, V, P) and Max (b, V, P).

4. Difference Matte effect: The Difference Matte effect creates

transparency by comparing a source layer with a difference layer,

and then keying out pixels in the source layer that match both the

position and color in the difference layer.

Fig. 1.7: Difference Matte Effect

Here you will get the following options:

1. View: This is to select the view type you want in the composition

window while working on the effect.

2. Difference Layer: This is to select the second layer for

Difference matting.

3. If Layer size is Differ: Here if the second layer you have selected

has different size then you can either align it to centre or stretch

to fit to the main video layer.

4. Matching Tolerance: Here you can increase or decrease the

selection range of the color you want to matte.
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5. Matching Softness: This is to match the softness of the color

you are selecting for matting.

6. Blur Before Difference: If you need blur edges for selection

and removal of a color range then you can increase this value.

5. Extract effect: The Extract effect creates transparency by keying

out (or extracting) a specified brightness range, based on a histogram

of a specified channel.

Fig. 1.8: Extract Effect

Here you will get the following options for correction and

modification:

1. Histogram: Here you can see and decide about selection of the

color by using the Histogram of the video.

2. Channel: Here you can select the channel of the video on which

you want to work for the effect like – Red, Green, Blue, Luminance

and Alpha

3. Black Point: Here you can select the white point for removal of

the color.

4. White Point: Here you can select the black point for removal of

the color.

5. Black Softness: Here you can select the black point’s softness

for removal of the color.

6. White Softness: Here you can select the white point’s softness

for removal of the color.

7. Invert: Here you can invert the selection you have done for

removal of the color range.
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6. Inner/Outer Key effect: The Inner/Outer Key effect isolates a

foreground object from its background. Even objects with wispy,

intricate, or indefinable edges can be clipped from their backgrounds

with minimal work.

Fig. 1.9: Inner/Outer Key effect

The options available here are as following:

1. Foreground Inside: This is used for selecting foreground mask

path.

2. Additional Foreground: This is used for selecting additional

foreground mask path.

3. Cleanup Foreground: This is used for cleaning up the

foreground mask area.

4. Cleanup Background: This is used for cleaning up the

background mask area.

5. Edge Thin: This is used for modifying the mask path’s edge’s

thickness.

6. Edge Feather: This is used for increasing or decreasing the

feather of mask edges.

7. Edge Threshold: This is used for setting the edge selection

threshold.

8. Blend with Original: You can blend the final our put with the

original image with this in a decided amount percentagewise.

7. Linear Color Key: The Linear Color Key effect uses RGB, hue, or

chroma information to create transparency from a specified key

color.
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Fig. 1.10: Linear Color Key effect

Here you will get the following options:

1. Preview: This is for preview of the selected color range and

adding or removing selected color’s range with the use of picker.

2. View: here you can decide the view you want to see while working

with this effect.

3. Key Color: You can select the key color here.

4. Match Colors: You can match the colors here for removal.

5. Matching Tolerance: Here you can set the strength of color

selection for removal.

6. Matching Softness: Here you can set the softness at the edges

of remaining objects after the effect is getting applied.

7. Key Operation: This is how you want the final result – key colors

or keep colors.

8. Luma Key Keying: The Luma Key effect keys out all the regions

of a layer with a specified luminance or brightness. The layer’s

quality setting does not influence the Luma Key effect.

Fig. 1.11: Luma Key effect
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Here you will get the following options for modification in the final

effect.

1. Key Type: Here you can select the key type from given options

like – Key Out Brighter, Key Out Darker, Key Our Similar and

key Out Dissimilar

2. Threshold: You can set range of the color for removal.

3. Tolerance: This is the strength of the effect.

4. Edge Thin: This is to increase or decrease the edge thickness of

color range from edges f remaining objects.

5. Edge Feather: here you can define the remaining edge’s softness.

9. Spill Suppressor: The Spill Suppressor effect removes traces of

the key color from an image with a screen that has already been

keyed out.

Fig. 1.12: Spill Suppressor effect

The options available here are:

1. Color to Suppress: This is to select the color for removal.

2. Color Accuracy: This is for selecting the color you want to

remove like - Faster or Better.

3. Suppression: This is to increase or decrease the range of the

color for removal.

1.3 Summery

In this unit you learned about various effects and their uses. All the effects

in After Effect are divided into various categories based on common

outputs or elements which they affect. You have learned following

categories and effects:
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a) Color difference Key Effect

b) Color Key Effect

c) Color Range Effect

d) Difference Matte Effect

e) Extract Effect

f) Inner/Outer Key Effect

g) Linear Color Key

h) Luma Key Effect

i) Spill Suppressor

The above effects are used to remove background or extract the

foreground from a video footage. In general these are called as chroma

or color key out effects. Some of these remove a particular color and

some work on alpha or luma value. Spill Suppressor is used to remove

the color spill on the foreground elements.

1.4 Self Assessment Test

1. What are various color key effects? Explain each one of them.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. Write in detail the procedure of removing a blue/green background

from footage.
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Write short notes on:

a. Color Key Effect

b. Color Range Effect

c. Difference Matte Effect

d. Luma Key Effect

e. Spill Suppressor Effect

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

1.5 Further Reading

After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe

After Effects CS4 Classroom in a Book, Brie Gyncild

Adobe After Effects CS5 Visual Effects and Compositing Studio

Techniques, Mark Christiansen

Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team

Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:

Essential and Advanced Techniques, Chris Meyer and Trish Meyer

The After Effects Illusionist: All the Effects in One Complete Guide,

Chad Perkins

1.6 Assignment

Using the above effects try to create a double role effect.
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Learning Objectives:

After reading this unit, you will learn:

· Learning about animation techniques

· Learning Motion Tracking

· Learning Stabilizing

· Learning Motion Sketching

: Structure :

2.1 Introduction

2.2 Advance animation techniques

2.3 Motion Tracking

2.4 Stabilizing

2.5 Motion Sketching

2.6 Summery

2.7 Self Assessment Test

2.2 Further Reading

2.9 Assignment

2.1 Introduction

In this Unit you will learn advance animation techniques like Motion

Tracking, Stabilizing and Motion Sketching.

When you see a hero jumping from the sky and getting down or a hero

jumping or running on a train you find it interesting and thrilling too.

These all are done with the use of Visual Effects.

The topics we are going to discuss here are highly used for compositing

in movies and serials you see these days. Let’s discuss about them in

detail now.

ADVANCED ANIMATION

TECHNIQUES
UNIT

2
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2.2 Advance animation techniques

Let’s talk about what is advanced animation techniques. These all are

different styles or techniques for making animations for movies, serials

and video advertisements. You see normally a CG character merged with

a real-time shot movie or you see hero and villain fighting in the sky

while jumping from a helicopter or plane. This looks like, how is it

possible in our real life and how this has been made? For these all effects

advanced animation techniques are invented and used by people.

These include Motion Tracking, stabilizing, motion sketching, etc.

techniques which are widely used these days. Let’s discuss about the m

in detail.

2.3 Motion Tracking:

The tracking basically means to match the scenes. The small points are

added which can be used for tracking. They are called trackers.

The motion tracking can be used in several manners, like:

1. Combining elements filmed separately, such as adding video footage

to the side of a city bus or a star to the end of a sweeping wand.

2. Animating a still image to match the motion of action footage, such

as making a cartoon bumblebee pursue a swaying flower.

3. Adding effects that follow a moving element, such as applying a

lens flare to a scene where the camera pans or making a ball glow.

4. Stabilizing footage, such as smoothing the wobble of footage shot

with a handheld camera.

5. Applying effects or transform properties to a layer using tracking

data in expressions, such as stretching a wire coil between two

objects.

Let’s see what the options available in Motion Tracking window are.
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Fig. 2.1: Motion Tracking Options

1. Track Motion: This is to activate the motion tracking option on the

selected video.

2. Motion Source: Here you will select the source (video) from which

you want to get the motion properties for the main video.

3. Current Track: This is to see the number of tracker that is selected

right now as there is more number of trackers you can get at one

time.

4. Track Type: This is to set the track type from the given types –

Stabilize, Transform, Parallel Corner Pin, Perspective Corner Pin

and Raw. Any one you can select as per the requirement.

5. Position / Rotation / Scale: Here you can select the source motion’s

type as Position, Rotation and Scale. You can select any one or more

as per the motion you want to get from the source.

6. Motion Target: This is to set the target video on which you want to

apply the tracked motion.

7. Analyze: Here you can analyze the motion tracing as how it will

look finally.

8. Reset / Apply: If after analyze you are not satisfied then you can

rest the motion tracking and if satisfied then apply it finally on the

target video.

9. Motion Tracker Options: Here you can select which property you

want to consider for selecting the tracker position and other source

points. The window you get here looks like the following figure.
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Fig. 2.2: Motion Tracker Options

2.4 Stabilizing:

Animation > Stabilize Motion or click Stabilize Motion in the Tracker

Controls palette.

The shots which are taken by the air borne camera or handled do not have

stabilization. The stabilization allows us to smooth the recorded footage

by removing the jerks. The motion appears smooth because the layer

itself moves incrementally to offset the unwanted motion. We need to

define a feature and search region. After Effects gives us two options

for stabilizing: Position and Rotation.

The same window you got for Motion Tracking contains options for

Stabilizing.

Fig. 2.3: Stabilizing Options

The only difference is the option –Stabilize is default selected here in

the Track Type. Stabilizing is very much useful for making the video

stable which you have shot for clay mation with a camera that does not
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have tripod where due to shaking of the camera person’s hand the video

gets jerky rotations and movements while shooting. To make this video

stable you can use stabilizing after once it is shot.

2.5 Motion Sketch

We can draw a path for the motion of a selected layer using Motion

Sketch, which records the position of the layer and the speed at which

we draw. As we create the path, After Effects generates a position key

frame at each frame, using the frame rate specified in the composition.

Motion Sketch does not affect key frames that we have set for other

properties.

You will get the window of Motion sketch from Window Menu. It has

options like the following figure shows.

Fig. 2.4: Motion Sketch Options

The options are:

1. Capture speed: This is on which speed you want to capture the

animation.

2. Smoothing: this is the smoothing of animation you capture.

3. Show – Wireframe / Background: here you can set the preview

type as you want to see only wireframe or real layer content.

4. Start: this is the start of the layer where you are doing motion

capture.

5. Duration: This is the duration of captured motion.

6. Start Capture: This button is to start capturing the motion.
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How to use: You can select the layer in Time Line for which you want to

make animation by simply dragging it in the composition window. Then

go to Motion Sketch window. Now press the button given at the bottom

of the window named – Start Capture. Then move the layer content by

simply selecting and dragging it in the composition window. You will

find the animation simply done as you dragged it as it has been recorded

here.

2.6 Summery

In this unit you learned about Motion Tracking and Stabilizing. You see

normally a CG character merged with a real-time shot movie or you see

hero and villain fighting in the sky while jumping from a helicopter or

plane. This looks like, how is it possible in our real life and how this has

been made?

The tracking basically means to match the motion of elements or camera

movement of two scenes or layers. To match two scenes, small points

are used which are called as trackers. You can track position only or

position & rotation or position & scale of an element in the scene with

the other scene.

Stabilizing is somewhat similar to motion tracking in technical terms. In

motion tracking motion of an element in one scene is applied to another

element other layer which means that in motion tracking two layers are

involved where as in case of stabilizing the tracked motion is applied on

the same scene to remove the jerks from the scene. These are generally

used in the scenes which are shot without tripod or a trolley or crane.

Motion Sketching is another way of animating layers in After Effects.

We can draw a path for the motion of a selected layer using Motion

Sketch, which records the position of the layer and the speed at which

we draw. As we create the path, After Effects generates a position key

frame at each frame, using the frame rate specified in the composition.

Motion Sketch does not affect key frames that we have set for other

properties.
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2.7 Self Assessment Test

1. Write in detail the procedure for motion tracking.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. Write in detail the procedure of removing jerks from a scene.

Write short notes on:

a. Motion Sketching

b. Tracker

c. 4 point Tracking

d. Stabilizing

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................
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..........................................................................

..........................................................................

2.8 Further Reading

After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe

After Effects CS4 Classroom in a Book, Brie Gyncild

Adobe After Effects CS5 Visual Effects and Compositing Studio

Techniques, Mark Christiansen

Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team

Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:

Essential and Advanced Techniques, Chris Meyer and Trish Meyer

The After Effects Illusionist: All the Effects in One Complete Guide,

Chad Perkins

2.9 Assignment

Take a jerky video and stabilize it.
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ROLE OF SELF INSTRUCTIONAL MATERIAL

IN DISTANCE LEARNING

The need to plan effective instruction is imperative for a suc-

cessful distance teaching repertoire. This is due to the fact that the in-

structional designer, the tutor, the author (s) and the student are often

separated by distance and may never meet in person. This is an increas-

ingly common scenario in distance education instruction. As much as

possible, teaching by distance should stimulate the student’s intellectual

involvement and contain all the necessary learning instructional activi-

ties that are capable of guiding the student through the course objec-

tives. Therefore, the course / self-instructional material are completely

equipped with everything that the syllabus prescribes.

To ensure effective instruction, a number of instructional design

ideas are used and these help students to acquire knowledge, intellectual

skills, motor skills and necessary attitudinal changes. In this respect,

students’ assessment and course evaluation are incorporated in the text.

The nature of instructional activities used in distance education

self- instructional materials depends on the domain of learning that they

reinforce in the text, that is, the cognitive, psychomotor and affective.

These are further interpreted in the acquisition of knowledge, intellec-

tual skills and motor skills. Students may be encouraged to gain, apply

and communicate (orally or in writing) the knowledge acquired. Intel-

lectual- skills objectives may be met by designing instructions that make

use of students’ prior knowledge and experiences in the discourse as the

foundation on which newly acquired knowledge is built.

The provision of exercises in the form of assignments, projects

and tutorial feedback is necessary. Instructional activities that teach motor

skills need to be graphically demonstrated and the correct practices pro-
vided during tutorials. Instructional activities for inculcating change in

attitude and behavior should create interest and demonstrate need and

benefits gained by adopting the required change. Information on the adop-

tion and procedures for practice of new attitudes may then be intro-

duced.



Teaching and learning at a distance eliminates interactive com-

munication cues, such as pauses, intonation and gestures, associated with

the face-to-face method of teaching. This is particularly so with the ex-

clusive use of print media. Instructional activities built into the instruc-

tional repertoire provide this missing interaction between the student

and the teacher. Therefore, the use of instructional activities to affect

better distance teaching is not optional, but mandatory.

Our team of successful writers and authors has tried to reduce

this.

Divide and to bring this Self Instructional Material as the best

teaching and communication tool. Instructional activities are varied in

order to assess the different facets of the domains of learning.

Distance education teaching repertoire involves extensive use of

self- instructional materials, be they print or otherwise. These materials

are designed to achieve certain pre-determined learning outcomes,

namely goals and objectives that are contained in an instructional plan.

Since the teaching process is affected over a distance, there is need to

ensure that students actively participate in their learning by performing

specific tasks that help them to understand the relevant concepts. There-

fore, a set of exercises is built into the teaching repertoire in order to

link what students and tutors do in the framework of the course outline.

These could be in the form of students’ assignments, a research project

or a science practical exercise. Examples of instructional activities in

distance education are too numerous to list. Instructional activities, when

used in this context, help to motivate students, guide and measure stu-

dents’ performance (continuous assessment)



PREFACE

We have put in lots of hard work to make this book as user-friendly

as possible, but we have not sacrificed quality. Experts were involved in

preparing the materials. However, concepts are explained in easy

language for you. We have included many tables and examples for easy

understanding.

We sincerely hope this book will help you in every way you

expect.

All the best for your studies from our team!



MOTION GRAPHICS (Software-Adobe After Effects)

Block 1 INTRODUCTION

UNIT 1 INTRODUCTION TO COMPOSTING
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Composition
 Types of Compositions
 Video Editing
 Types of Editing
 Video Broadcasting Standards
 After Effects Interface
 Importing files in After Effects
 Creating New, Opening and Saving compositions
 Familiarity with Timeline

UNIT 2 EXPLAINING TOOL BOX
Learning Objectives:

 Building Blocks & Get Ideas
 Inspiration from Visual Arts
 Understand Flow Charts
 About the Tool Box
 About the functioning of various tools and where they can be

used
 About Guides and Grids
 Various commands in Layer, View and Edit Menu
 Functions of various switches in the timeline/layer menu.
 Familiarity with Timeline

UNIT 3 LAYER NESTED COMPOSITION  AND MASKING
Learning Objectives:

 About Masking
 How Masking is done and various uses of masking
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.

Block 2: ANIMATION AND EFFECTS
UNIT 1 ANIMATION
Learning Objectives:

 How to do Animation in After Effects
 How to increase or decrease the speed of the footage
 Nested Compositions and its uses
 Various type of Layer options like Blending, Time remapping,

etc.
UNIT 2 EFFECTS
Learning Objectives:

 Various Effects available in After Effects



 Use of Blur and Sharpen Effects
 Use of 3D Effects
 Use of Channel
 Use of Colour Correction

UNIT 3 SOME MORE EFFECTS
Learning Objectives:

 Various Effects available in After Effects
 Use of Render Effects
 Use of Stylize Effects
 Use of Text Effects
 Use of Audio

Block 3 ADVANCED KEYING,MATTE AND ANIMATION
TECHNIQUE

UNIT 1 KEYING AND MATTE
Learning Objectives:

 Learning about advanced Keying
 Learning about advanced matte

UNIT 2 ADVANCED ANIMATION TECHNIQUES
Learning Objective

 Learning about animation techniques
 Learning Motion Tracking
 Learning Stabilizing
 Learning Motion Sketching

Block 4 3D AND RENDERING IN AE
UNIT 1 3D MOTION IN AFTER EFFECTS
Learning Objective

 Learning about 3D in After Effects
 Learning use of 2D layers in 3D World
 Learning about 3D layer options and transformation Properties
 Learning 3D compositions of position, rotation, shadow,

reflection and other effects by examples
UNIT 2 RENDERING
Learning Objective

 Learning to make Textures for Different Creatures
 Learning to make Textures for Cat, Rat, Lion, Reptiles, Birds,

Fishes, Turtles, Mammals, Wild Animals, Pets, Etc
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3D MOTION IN AFTER
EFFECTS

UNIT
1

Learning Objectives:
After reading this unit, you will learn:
· Learning about 3D in After Effects
· Learning use of 2D layers in 3D World
· Learning about 3D layer options and transformation Properties
· Learning 3D compositions of position, rotation, shadow,

reflection and other effects by examples

: Structure :
1.1 Introduction
1.2  Introduction to 3D in After Effects
1.3  Use of 2D layers in 3D world
1.4 3D layer option and transformation properties
1.5 Examples of 3D compositions of position, rotation, shadow,

reflection and other effects
1.6  Exercise
1.7  Summery
1.8  Self Assessment Test
1.9  Further Reading
1.10 Assignment

1.1 Introduction
Here you are going to learn 3 Dimensional effects and layers and
controlling them in After effects for making visual and special effects.
This includes compositing 3D objects in real time shooting and setting
the final out put more real as all the things where in the same scene. You
can get nice elements here like – lights, camera, materials, transmission,
orientation, etc for making the output more realistic and eye catching.

1.2 Introduction to 3D in After Effects
The 3d animation in After Effects is excellent. With this we can animate
the layer or the objects in 3d space. Here in a 3d layer we get all the
options of any of the 3d software like lights, materials, transmission,
orientation, etc.
This layer provides us all the 3 axis like X, Y and Z axis. The camera
movements in this layer are exotic. Sometimes the advertisements are
made in such a way that it becomes very confusing for us to understand
whether the scene is original or virtual.



2

Now let us see all the options that are available in the transformation
panel of the timeline window.
Transforms:

Fig. 1.1: Transforms Options
1. Anchor Point: The anchor point defines the centre point of the

selected layer. With this we can define the rotation angle of the
object and the centre axis of the layer.

2. Position: With this option we can set the “Position” of the layer
both when still as well as animated.

3. Scale: With this option we can set the “Scale” of the layer both when
still as well as animated.

4. Rotation: Helps us in rotating the layer in the composition window.
5. Opacity: With this we can set the opacity amount of the layer both

when still as well as when animated.
Material options: These all are available in 3D Layer properties only.
So let’s talk about them in 3D layer property’s discussion coming next.

1.3 Use of 2D layers in 3D world
You can import 2D images like JPEG, TIFF, tga, PNG, GIF, etc and make
them 3D layer for making their 3D animation for various purpose. Also
you can import individual layers of psd file as well as all layers merged
of it and make it 3D layer for animation.
You can make Solid layers and shape layers in After Effect and make
them 3D layer for 3 Dimensional animations. Making a 2D layer as a 3D
layer is very useful for making logo animations as well as stop motion
animations. It is very much used for making motion graphics which you
normally see in advertisements, serials and movies titles and in-between
the movies and serials sometimes as a creative part of them.
After converting a 2D layer in to 3D layer you cannot get the depth
generated by itself but now you can move, rotate and scale the layer in 3
Dimensional space for generating good animations.

1.4 3D layer option and transformation properties
When you will check the 3D Layer button given in the Time line on at the
side of a particular layer it will become 3D layer.

Fig. 1.2: 3D Layer toggle Button
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Here you will get all properties of transformation in 3 Dimension as
you get the same properties of a 2D layer in 2 Dimensions only. Here
you will get the Z axis on and on it you can transform, rotate and scale
the object now.

Fig. 1.3: 3D Layer Transformation Properties
1. Anchor Point: The anchor point defines the centre point of the

selected layer. With this we can define the rotation angle of the
object and the centre axis of the layer.

2. Position: With this option we can set the “Position” of the layer
both when still as well as animated.

3. Scale: With this option we can set the “Scale” of the layer both when
still as well as animated.

4. Orientation: With this option we can set the “Orient” of the layer
both when still as well as animated on the entire 3 axis like X, Y as
well as Z. here the layer rotates along the shortest possible rotational
path in 3d space.

5. X rotation: Helps us in rotating the layer on the “X” axis.
6. Y rotation: Helps us in rotating the layer on the “Y” axis.
7. Z rotation: Helps us in rotating the layer on the “Z” axis.
8. Opacity: With this we can set the opacity amount of the layer both

when still as well as when animated.
Material options: These all are available in 3D Layer properties only.

Fig. 1.4: Material Options
1. Cast Shadows: This helps us to create or to display the shadow on

the base. The direction and the angle of the shadow is determined by
the angle of the light.

2. Light Transmission: This option allows us to transmit the light
through the layer. This is a best option to show the transmission of
the light from the designer glass.
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3. Accept Shadows: With this option we can determine whether the
base should accept the shadow or not.

4. Accept Lights: With this option we can determine whether the base
should accept the light or not.

5. Ambient: With this we can determine the non directional reflectivity
of the light.

6. Diffuse: With this we can determine the omni directional reflectivity
of the light.

7. Specular: With this we can determine the directional reflectivity of
the light.

8. Shininess: Specifies the size of the specular highlight.
9. Metal: Specifies the color of the specular highlight.
1.5 Examples of 3D compositions of position, rotation, shadow,

reflection and other effects
You can take simple 2D layers and make them 3D layers for making
simple motion graphics for advertisements, 2D Animations with an
illusion of 3D Depth. You can also make logo animations with them.
Also with the help of these you can make and shot a 3 Dimensional motion
graphics for different purpose as you can get lights, camera, reflection,
shadows, etc here.
In the following figure you can see one simple 3D scene generated with
the use of 2D layers which are converted in to 3D layers.

Fig. 1.5: 3D Composition
In the above figure you can see a light is placed so the scene becomes
like a 3 Dimensional scene. If we put camera in the same scene and
change the position of it, it will look like a 3D environment. You can see
it in the following figure.
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Fig. 1.6: 3D Composition from camera angle

1.6 Exercise
3D spinning cube:
For this exercise we need six footages or images (square and equal size
is preferred). In this exercise I shall be using 6 solid layers. After effects
has the capability to convert each independent layer in 3D, that’s what
we will be going to use for this exercise. As the layers used in this tutorial
are square and equal in size, if you are using different footages or images,
you may have to adjust the values.
1. First thing first, open After Effects and create a new composition

with PAL D1 presets (720 X 576 @ 25 fps).

Fig 1.7 New Composition settings
2. Create six solid layers of different color with 360 X 360 pixels.
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Fig 1.8 New Layer Settings
3. Turn on the 3D Layer switch (under 3D cube) for all the layers and

choose 4 views mode from the composition window.

Fig 1.1 All 6 layers with 3D Layer switch enabled
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4. Now select all layers, press ‘p’ then “Shift + r” and change their
transformations as following:
a. Layer 1 (Yellow): Position: 180,288,0; Y Rotation: 10
b. Layer 2 (Green): Position: 360,288,180
c. Layer 3 (Cyan): Position: 540,288,0; Y Rotation: 10
d. Layer 4 (Blue): Position: 360,288,-180
e. Layer 5 (Magenta): Position: 360,108,0; X Rotation: 10
f. Layer 6 (Red): Position: 360,468,0; X Rotation: 10

Fig 1.10 Transformation values of the Layers
5. Now the 3d Cube is ready. To bind all of them together and to spin

the cube at its center point we need a layer to which we can parent
all the layers. To do the same create a “Null Object” from the layer
menu and let it be at the center of the composition.

6. If you want to spin the cube in 3d then convert the Null layer into 3D
layer by turning on the 3D cube switch.

7. Link (parent) all the other layers to the Null Object. Now all the
layers will follow the transformation of Null Object that is if you
move or rotate the Null Object all the other layers will follow the
same movement and rotation along the anchor point of the Null
Object.
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Fig 1.11 Displaying the linked layers to the Null Object (Null1)
8. Select Null Object and press ‘r’ to turn on the orientation

transformation for the Null object. We can create key frame for the
same or we can also write a simple expression to spin the Null Object
in 3D space.

9. Alt + Left Click on the stop watch of the orientation. This will bring
forth the expression box in the timeline. As the Null Object is 3D
layer right now, so we need to assign three values to rotate it in each
axis. If you want to rotate it only one or two axis then you only
needs to provide only one value of the expression. In the expression
text box we need to input values as “[ 0, 0, 0 ]” (excluding the quotes).
The first zero is for X, second is for Y and third is for Z. So we need
to our expression to change the zero into some number. There some
in-built variables as well as function which we can use to create the
expressions. In this exercise, we will be using “time“ variable which
gives the current time of the timeline. So when we will run the
playback head it will change with every frame. To rotate it in a
particular rhythm we will be using in-built trigonometric functions
– “sin and cos”. So our expression will look something like this:

[ Math.sin(time)*10, Math.cos(time)*135, Math.sin(time)*180 ]

Fig 1.12 Expression in the timeline.



9

The ‘sin’ and ‘cos’ functions give values between -1 and 1 so the change
will not be too much. To increase the amount of change we have multiplied
these functions with different values. You can vary these values to see
the difference in the spinning of the Cube.
With this our spinning 3D cube is ready. Instead of the solid layers you
can also import six different images of footages and do the same
procedure to form 3D cube out of them.

1.7 Summery
In this unit you learned about 3 Dimensional effects and layers and
controlling them in After effects for making visual and special effects.
This includes compositing 3D objects in real time shooting and setting
the final out put more real as all the things where in the same scene. You
can get nice elements here like – lights, camera, materials, transmission,
orientation, etc for making the output more realistic and eye catching.
This layer provides us all the 3 axes like X, Y and Z axis. The camera
movements in this layer are exotic. Sometimes the advertisements are
made in such a way that it becomes very confusing for us to understand
whether the scene is original or virtual.
You can import 2D images like JPEG, TIFF, tga, PNG, GIF, etc and make
them 3D layer for making their 3D animation for various purpose. Also
you can import individual layers of psd file as well as all layers merged
of it and make it 3D layer for animation. After converting a 2D layer in
to 3D layer you cannot get the depth generated by itself but now you can
move, rotate and scale the layer in 3 Dimensional space for generating
good animations.
You will get all properties of transformation in 3 Dimension as you get
the same properties of a 2D layer in 2 Dimensions only. Here you will
get the Z axis on and on it you can transform, rotate and scale the object
now. Also with the help of these you can make and shot a 3 Dimensional
motion graphics for different purpose as you can get lights, camera,
reflection, shadows, etc here.

1.8 Self Assessment Test
1. Write in detail the procedure for converting a layer from 2D to 3D.

What are the major differences in both of them?

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................
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..........................................................................

..........................................................................

..........................................................................

2. Write in detail about the material options available for 3D layers.

Write short notes on:

a. 3D Switch

b. Orientation Transformation

c. Metal option

d. Cast Shadows

e. Light Transmission.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

1.9 Further Reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe

After Effects CS4 Classroom in a Book, Brie Gyncild
Adobe After Effects CS5 Visual Effects and Compositing Studio

Techniques, Mark Christiansen
Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:

Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,

Chad Perkins

1.10 Assignment
Create a 3D composite using lights and shadows.
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Learning Objectives:
After reading this unit, you will learn:
· Learning to make Textures for Different Creatures
· Learning to make Textures for Cat, Rat, Lion, Reptiles, Birds,

Fishes, Turtles, Mammals, Wild Animals, Pets, Etc

: Structure :
2.1 Introduction
2.2 All rendering options including type of outputs, quality, frame

& fields etc.
2.3 Preview
2.4 Rendering Que. Proxy and there usage
2.5 The workflow in production environment
2.6 Templates & Preferences
2.7 Exporting in different formats
2.8 Summery
2.9 Self Assessment Test
2.10 Further Reading
2.11 Assignment

2.1 Introduction
Here in this Unit you will learn about how to get the rendered final output
of a composition that you have made in After Effects.
You may need the output in different types of formats like avi, compressed
avi for broadcasting, image sequences or any one image from a particular
time of the composition. For all these let’s talk about rendering in After
Effects.

2.2 All rendering options including type of outputs, quality, frame
& fields etc.

When we create output, the layers of a composition and each layer’s
masks, effects, and properties are rendered frame by frame into one or
more output files or, in the case of a sequence, into a series of consecutive
files.
We can render movies to use in a wide variety of ways, including the
following:
1. To play on systems those have a movie player application.
2. To record on videotape for playback on NTSC and PAL broadcast

television equipment.

RENDERINGUNIT
2
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3. To record to 35mm film for editing into a cinema release.
4. To play from DVD, from CD-ROM, or as streaming video on the

World Wide Web.
5. To import into nonlinear editing systems, such as Avid or Media 20,

for final output.
6. To broadcast on HDTV
The Render Queue window looks like the following figure and it can be
opened with Make Movie Command available in Composition menu.

Fig. 2.1: 3D Render Queue Window
Here if you press the Render Settings > Based on Best Settings button
then you will get the following window of settings for final output.

Fig. 2.2: Render Settings Window
Composition Options: Here you will get the rendered output of selected
composition only and that composition’s name will be displayed here as
in the above figure you can see the name “woods”.
Here you can set the quality of the final video, resolution of the video,
Final dimensional size of the video in pixels, etc.
Also you can set any proxy use for rendering. You can make the effects
on or off as if you need them to be in final output or not. You can decide
if you want the guide layers to be rendered or not. You can change the
color depth here as you want current settings, 0 bits per channel, 16 bit s
per channel or 32 bits per channel in the final output.
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Time Sampling: Here you can set the frame blending on or off. You can
change the field Render off or can change it. You can make the motion
blur on or off for all layers or the layers where it is applied in the
composition. You can change the time span here.
In the frame rate options: You can set the default set composition’s frame
rate for final out put or you can change it by writing it in the box given
besides use this frame rate by making the option checked. You can change
the starting and ending point of the final rendered output from the custom
button given besides the End timings given at the bottom right side of
the window.
In the Render Queue you can click on Output module > Lossless to get
the options of Rendering different formats.

Fig. 2.3: Output Module Settings Window
Here you can define the output type with the use of Format options which
includes the following options.

Fig. 2.4: Format Options for Render
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Also you can set the compression method with the use of Format button
given in the Video Output Options.

Fig. 2.5: Video Output Compression
For Audio settings in output you will get options in the bottom of the
same window with following options.

Fig. 2.6: Audio Rendering Options
Also you can change the video outputs options like Channels, Depth and
Colors from the Video Output options shown in the following figure.

Fig. 2.7: Video Output Options
You can also change the Stretch and Crop options for stretching the size
and crop the size of the output in regards to the composition you are
rendering here.
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Fig. 2.8: Stretch and Crop Options

2.3 preview
You can get the preview of the composition you have made with the use
of Preview command available in Composition menu.

Fig. 2.9: Render Settings Window
Here you can get different types of preview like RAM Preview,
Wireframe Preview and Motion with Trails for video.
For Audio you will get Audio Preview (Here Forward) and Audio Preview
(Work Area).
Let see how they give different types of previews:
1. RAM Preview: As the other two video previews cannot give you

video preview with sound this is the only preview that gives you
video and audio preview together. This preview is deepened on the
RAM available and allocated to After Effects in your system as it
uses that and make the preview for you that you can see in
composition window.

2. Wireframe Preview: This preview shows only wireframes of all
layers and their content which saves the RAM as well as gives preview
quickly.
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3. Motion with Trails for video: this preview shows only the trails
of the moving layer contents where you can check the animation
only for smoothness of the same.

2.4 Rendering Queue, Proxy and there usage
The status line in the Render Queue window provides important
information on the results of the rendering process. Render queue status
options include the following:
1. Un queued:

The render item is listed in the Render Queue window but is not
ready to render. Confirm that we have selected the desired render
and output module settings, and then select the Render option to
queue the composition.

2. Queued:
The composition is ready to render.

3. Needs Output:
An output filename has not been specified for one of the output
modules.

4. Failed:
After Effects was unsuccessful in rendering the movie. Use a text
editor to view the log file for specific information on why the
rendering was unsuccessful.

5. User Stopped:
The rendering process was stops.

6. Done:
The rendering process for the item is complete.

2.5 The workflow in production environment
In Production environment there are so many people working together
as well as on one file there may be a big number of people working at the
same time. In these kinds of situations it is very typical to maintain the
same thinking of all people together and even render the final output as
the team leader wants.
So, Normally in Production, they make charts and plans for getting final
outputs as per the requirements. So many compositions are made and
then rendered together in a sequence for final outputs at the same time.
2.6 Templates & Preferences
In the Edit Menu you will get the Templates and Preferences options.
You can get the Templates options from the edit menu as shown in the
following figure.
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Fig. 2.2: Templates options
Here you will get Render settings and Output Module options.
1. Render settings: This gives you two categories for setting the

rendering output.
i. Defaults: In this window you can change and set a render setting as

per your requirement with desired settings in given options like
Movie Default, Frame Default, Pre-Render Default, Movie Proxy
Default, Still Proxy Default, etc.

Fig. 2.11: Render Settings Templates
ii. Settings: Here you can set the settings name, you can take a new

setting or edit the old one, You can take a duplicate setting and also
you can delete any saved setting.

2. Output Module: Here you have similar options for rendering with
the following options.
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Fig. 2.12: Output Module Templates
Preferences: The preferences options you can get just below to the
template options in Edit Menu.

Fig. 2.13: Preferences options
The options and categories available here are as followings:
1. General: Here you can get the general options required for working

in after effects.

Fig. 2.14: General Preferences options
You can get the undo levels from 1 to 99 as per your requirements.
You can set other things like showing tool tips, create layers at
composition start time ,etc. as shown in the above figure.

2. Previews: Here you can set the preview styles as if you need OpenGL
to be used for preview or not. You can also change the adaptive
resolution limits from here.
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Fig. 2.15: Previews Preferences options
3. Display: This helps you to set the display styles for Motion Path

and also you can disable thumbnails in project panel from here.

Fig. 2.16: Display Preferences options
4. Import: Here you can set the importing options for images as what

duration you want the image to take as number of frames at the time
of importing the image. For video you can change the FPS at the
time of importing it.

Fig. 2.17: Import Preferences options
5. Output: here you can set the Output settings for Volumes and

segment sequence at a particular file.
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Fig. 2.18: Output Preferences options
6. Grids & Guides: here you can change the Grids and Guides colors,

styles and subdivisions. Also you can change the safe margins’
settings here.

Fig. 2.19: Grids & Guides Preferences options
7. Label colors: You can make a list of colors of your own choice

here to assign them later to the elements in the project window for
your easy work.

Fig. 2.20: Label Colors Preferences options
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8. Label Defaults: Here you will assign the decided colors you have
set in previous preferences options of Label Colors to the elements
of project elements like video, audio, camera, light, composition
which will be displayed in the project window for your easy work.

Fig. 2.21: Labels Default Preferences options
9. Memory & Cache: here you will allocate the memory from your

computer system to After Effects for fast work. After Effects cannot
take more than 2 GB ram at the same time. Also you can set the
cache levels you want to use for After Effects here.

Fig. 2.22: Memory & Cache Preferences options
10. Video Preview: here you can set the video preview style for the

monitor or IEEE 2394 (OHCI Compliant) preview. Then you can
set the quality you need for the previews.

Fig. 2.23: Video Preview Preferences options
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11. User Interface Colors: This is useful for setting the interface
colors of After Effects for the comfort of user working in it. You
can increase or decrease the brightness of the interface as you need.

Fig. 2.24: User Interface Preferences options
12. Auto save: If you want to make After Effects save the project in

which you are working by itself after certain time periods then you
can set the same from here.

Fig. 2.25: Auto-Save Preferences options
13. Multiprocessing: If you want to render multiple frame at the same

time use this option.

Fig. 2.26: Multiprocessing Preferences options
14. Audio Hardware: Here you can set the Audio Hardware you want

to use while working in After Effects.
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Fig. 2.27: Audio Hardware Preferences options
In the above figure you can see the settings available in this window
which you can get by clicking on the settings button.

15. Audio Output Mapping: This is for setting the Audio Mapping
Settings in After Effects.

Fig. 2.28: Audio Output Mapping Preferences options

2.7 Exporting in different formats
You can use the Export options available in the File menu shown in the
following figure for various purposes.

Fig. 2.29: Export options
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Here you can export the file in various formats like Adobe Clip Notes,
Adobe Premiere Pro Project, Adobe Flash (SWF), 3G, AIFF, AU, AVI,
DV Stream, Flash Video (FLV), FLC, Hinted Movie, Image Sequence,
MPEG-4, QuickTime Movie and Wave. These all are used in various
ways for different purposes. All these have their own settings and options
for exporting in them. Once you will select any one of them you will get
the settings available for exporting them.

2.8 Summery
In this unit you learned about how to get the rendered final output of a
composition that you have made in After Effects. You may need the output
in different types of formats like .avi, compressed .avi for broadcasting,
image sequences or any one image from a particular time of the
composition. For all these let’s talk about rendering in After Effects
While rendering, the layers of a composition and each layer’s masks,
effects, and properties are rendered frame by frame into one or more
output files or, in the case of a sequence, into a series of consecutive
files.
you can set any proxy use for rendering. You can make the effects on or
off as if you need them to be in final output or not. You can decide if you
want the guide layers to be rendered or not. You can change the color
depth here as you want current settings, 0 bits per channel, 16 bit s per
channel or 32 bits per channel in the final output.
You can set the default set composition’s frame rate for final out put or
you can change it by writing it in the box given besides use this frame
rate by making the option checked. You can change the starting and ending
point of the final rendered output from the custom button given besides
the End timings given at the bottom right side of the window.
You can get the preview of the composition you have made with the use
of Preview command available in Composition menu. Here you can get
different types of preview like RAM Preview, Wireframe Preview and
Motion with Trails for video.For Audio you will get Audio Preview (Here
Forward) and Audio Preview (Work Area).

2.9 Self Assessment Test
1. Write in detail the procedure for rendering a composition in

compressed avi format.

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................
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..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2. What is proxy? Write in detail the procedure for rendering proxies.
Write short notes on:

a. Render Queue window.
b. Various Formats available for rendering
c. RAM Preview
d. Audio Previews

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

..........................................................................

2.10Further Reading
After Effects Apprentice, Second Edition, Chris and Trish Meyer Adobe
After Effects CS4 Classroom in a Book, Brie Gyncild
Adobe After Effects CS5 Visual Effects and Compositing Studio
Techniques, Mark Christiansen
Adobe After Effects CS5 Classroom in a Book, Adobe Creative Team
Creating Motion Graphics with After Effects, 5th Edition, Fifth Edition:
Essential and Advanced Techniques, Chris Meyer and Trish Meyer
The After Effects Illusionist: All the Effects in One Complete Guide,
Chad Perkins
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2.11 Assignment
Render a composition in compressed avi, mov and targa image sequence.
Adobe After Effects


